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Executive Summary 

Here’s a quick overview of recent updates designed to improve your experience and system functionality: 

1. Future Date Entry Restriction (EII #130398): Prevents staff from entering activities scheduled on 
future dates to maintain data integrity. 

2. Appointment Search Filter (EII #131826): New icon to auto-update appointment search dates for 
easier navigation. 

3. Procedure Code Descriptions Update (EII #130767): UI changes to support inclusion of procedure 
code descriptions, facilitating accurate billing. 

4. Alert on Medication Discontinuation (EII #129496): Prescribers receive alerts when a medication 
order is discontinued based on new preferences. 

5. Weight-Based Dosage Calculator (EII #127274): New feature calculates pediatric medication 
dosages and validates against thresholds, enhancing clinical safety. 

6. Titration/Taper Functionality (EII #127483): Streamlined order management by enabling multiple 
medication steps in Order Sets. 

7. Care Coordination Enhancements (EII #130964): New sections in the Contact/Referral Organization 
screen to support care coordination workflows. 

8. PDF Rendering Performance (EII #131718): Improvements in the performance and flexibility of PDF 
rendering for Client Orders. 

9. Core NOMs Document Updates (EII #130801 & EII-130802): Enhancements for client assessment 
tracking and reporting. 

10. Service Overlap Notifications (EII #130780): Introduces a warning for overlapping services and 
hardstop validation for duplicates in Group Service Detail. 

11. Client Consent Documentation (EII #131753): Updated core document for federal customers to 
manage data sharing via API FHIR Server or HIE. 

12. Searchable Dropdown for Client Selection (EII #123604): Enhances workflows by improving client 
selection efficiency in mobile applications. 

13. UDS Table 6B Updates: Aligns to 2025 specifications across multiple sections as mentioned below, 
with new date functionalities for record fetching. 

• The UDS Report- 6B Details – Section H (‘Statin Therapy for the Prevention and Treatment of 
Cardiovascular Disease Report’). (EII # 129476) 

• The UDS Report- 6B Details – Section I- Ischemic Vascular Disease (IVD): Use of Aspirin or 
Another Antiplatelet’ . (EII #129477) 

• The UDS Table 6B Details - Section J - Colorectal Cancer Screening’ Report’.(EII # 129478) 

• The UDS Table 6B Details: Section A and B: Demographic Characteristic of Prenatal Care 
Patients’. (EII#129482) 

• The UDS Report- 6B Details – Section C - Childhood Immunization Status’ (EII # 129471) 

• The UDS Table 6B Details- Section N - Initiation and Engagement of Substance Use Treatment 
(CMS137v13)’. (EII #129610) 
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14. Medication Discontinuation Notifications (EII #130666): New preference option added to alert 
providers of medication discontinuation by nurses. 

15. Patients by ZIP Code Report Update (EII #131686): Aligns report to ensure only relevant patients 
are included. 

16. Patients by Age and Sex Report Update (EII #131688): Updates for accurate client counts and data 
display for the report. 

17. Consistency in Scanned Documents (EII #131703): Core header and footer added to maintain 
document uniformity. 

18. Enhanced MAT Management Search (EII #132198): Users can search clients by DOB, SSN, MRN, 
alongside name and ID, improving usability. 

19. UI Navigation Enhancements (EII #129990): Front-end UI provided for navigation setup between list 
and detail screens. 

20. Patient Refill Requests Tab (EII #131855): The integration of Intelichart/Patient Portal into the Rx 
application introduces a new feature aimed at enhancing user experience for managing medication refills. 
This allows requested medication refills to be displayed separately on the Start Page. 

21. Inactive NDC Identification (EII #130733): Conditional formatting in SmartCare RX to highlight 
medications with inactive National Drug Codes. 

*** DISCLAIMER: The document is only available to those customers who have purchased an annual 

subscription. It is a premium add-on to SmartCare and not included in SmartCare Base Subscription.  If 

you are interested in learning more about this document, please contact your account manager.  
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Audience 

These release notes are for general SmartCare™ users trained in the basic workflow and use of 
SmartCare™.  

Applicable Releases 

The functionality documented these release notes supports SC.CORE.6.0_1.37.000.2508.001 and later.  

Permissions 

You can only access screens/items granted per your user login referred to as Permissions. Depending on 
your current level of permissions, you may need to contact your system administrator to have your 
permissions changed.  

Global Codes, Recodes, and Configuration Keys 

Refer to the Global Codes, Recodes, and Configuration Keys sections of these release notes for a list 
and definition of each code or key.  
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TASKS LIST -‘ACTIVE CHANGE’ (10) 
Note: An active change is a product update that is automatically applied with the build and does not 
require any setup or action from the customer to take effect. 

Sl. No Task No Summary Module Name 

1 EII # 130398 Restricting Future Activity Updates Activity Tracker 

6 EII # 131826 Appointment Search: Added new icon to 

advance the search to the next 15 days. 
Appointment Search 

57 EII # 130801 NOMS Document Updates - 2025 

 

Documents 

59 EII # 131753 Change in ‘Consent to Share Health 

Information’ document. 

Documents 

72 EII # 130780 Group Services – Warning messages display 

for Overlap group services. 

Group Services 

95 EII # 123604 Implementation of Searchable drop down for 

client field in Create Service and Create 

Documents screen in Mobile Web App 

Mobile 

107 EII # 130802 NOMS File Mapping and List page Updates Documents 

120 EII # 130767 Travel Line Configuration: Implementing a front-

end configuration to allow SV101-07 procedure 

code descriptions for 837P claim files, 

supporting accurate service line billing. Front-

end implementation. 

Charges/Claims 

 

129 EII # 130733 Implementation of conditional formatting within 

the SmartCare RX module to identify 

medications associated with inactive National 

Drug Codes (NDCs). 

Rx Application 

130 EII # 131855 Implementation to display Patient Refill 
Requests tab on the Start Page of the RX 
application 

Rx Application 
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TASKS LIST-‘PASSIVE CHANGE’ (39) 
Note: A passive change is a product update that is applied with the build but requires the customer to 
complete configuration or other setup steps before the new functionality can be used. 

Sl. No Task No Summary Module Name 

2 EII # 130184 MCO tables are included in the Adhoc 
Reporting 

Adhoc Reporting 

3 EII # 130887 MCO tables are included in the Adhoc 
Reporting- SQL View 

Adhoc Reporting 

8 EII # 131750 To implement the logic, change in 270/271 

eligibility record days in the past and days in the 

future.` 

Batch Eligibility 

9 EII # 131752 To implement the change in the logic of 
270/271 eligibility record days in the past and 
days in the future. 

Batch Eligibility  

15 EII # 130766 Travel Line Configuration: Implementing a 
front-end configuration to allow SV101-07 
procedure code descriptions for 837P claim 
files, supporting accurate service line billing. 
Back End changes implementation 

Charges/Claims 

24 EII # 130941 Implementation to convert the "Client is an 

Adult with Guardian" icon a Client Flag. 
Client Flags 

33 EII # 127274 To enable Client Order screens to auto-

calculate total dose and to trigger weight-

based overdose alert requiring prescriber 

acknowledgment. 

Client Orders  

34 EII # 127483 Implementation of Lifestream Titration 

templates / favorites. 

Client Orders 

35 EII # 129496 PC: SmartCare to send an alert to a Prescriber 
when a nurse discontinues a medication order 
in SmartCare Orders. 

Client Orders 

36 EII # 131718 Implementation of Queue PDF 

Generation/Render Process for Client Orders 
Client Orders 

45 EII # 128533 Added Module and Screen Details for few 

existing configuration key 

Configuration Keys 

46 EII # 130964 Implemented a new section ‘Needs This 
Organization Addresses’ and ‘Contacts’ in 
‘Contact/Referral Organization’ screen. 

 

Contact/Referrals 

47 EII # 131829 Suicide Risk Assessment: Space issue in PDF Core Assessment 
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48 EII # 131920 Core Assessment initialization logic has been 

implemented for the 'Borderline Symptom List 

(BSL-23)' document which is added as tab. This 

tab's data will be initialized based on the client’s 

Episode, using the existing system 

configuration key 

‘AssessmentToInitializeFromPreviousEpisode’ 

Core Assessment 

55 EII # 132077 Added ‘Do Not Render PDF Immediately’ 

checkbox for ‘Client orders’ in the Document 

Codes Detail screen.  

Document Codes 

56 EII # 130321 Implemented a warning message to users 
when the logged-in staff is not authorized to 
author a document. 

Documents 

58 EII # 131639 Implementation of alert message stating 
"System failed to generate the pdf" will be sent 
to staff and author. 

Documents 

66 EII # 129990 Implementation of automatic hyperlinks in DFA 
list pages. 

Dynamic Forms (DFA) 

80 EII # 132102 Added 'Interface Status' column in the 
Orders(My Office) and Client Orders(Client) list 
page.  

Interfaces 

81 EII # 131648 To display the Scheduled for Date on the 
Medication Inventory Transaction List and 
Detail screen. The nurse will have the visibility 
of the Scheduled for Date. 

Methadone 

83 EII # 132198 Implemented new search options for the client 

search on the MAT Management list page using 

their DOB/SSN/MRN. 

Methadone 

99 EII # 130666 Added checkbox 
NotifyForDiscontinuedMedications in My 
Preferences screen 

My Preferences 

100 EII # 129471 Implementation of the report ‘UDS Table 6B 
Section C - Childhood Immunization Status’ to 
2025 Standard. 

My Reports/UDS 
Reports 

101 EII # 129476 Implementation of the ‘UDS Table 6B Details - 
Section H- Statin Therapy for the Prevention 
and Treatment of Cardiovascular Disease 
Report’ to 2025 Standard.  

My Reports/UDS 
Reports 

102 EII # 129477 Implementation of the ‘UDS Table 6B Details- 
Section I - Ischemic Vascular Disease (IVD): 
Use of Aspirin or Another Antiplatelet’ report to 
2025 Standard. 

My Reports/UDS 
Reports 
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103 EII # 129478 Implementation of the ‘UDS Table 6B Details - 
Section J - Colorectal Cancer Screening’ 
Report’ to 2025 Standard. 

My Reports/UDS 
Reports 

104 EII # 129482 Implementation of the ‘UDS Table 6B Details: 
Section A and B: Demographic Characteristic 
of Prenatal Care Patients’ to 2025 standard. 

My Reports/UDS 
Reports 

106 EII # 130339 Changes are implemented to the ‘UDS Table 5 
Staffing and Utilization’ report for the reporting 
year 2025. 

My Reports/UDS 
Reports 

108 EII # 131629 New changes are implemented to the 
Evidence Based Practices – IPP T3 Indicator 
Report. 

My Reports/UDS 
Reports 

109 EII # 131686 Changes are implemented to the ‘UDS Table 
Patients by ZIP Code’ report for the reporting 
year 2025. 

My Reports/UDS 
Reports 

110 EII # 131688 Changes are implemented to the ‘UDS Table 
3A: Patients by Age and by Sex’ report for 
reporting year 2025. 

My Reports/UDS 
Reports 

117 EII # 132223 Implementation of ‘Staff 3PL Update Report’. My Reports/UDS 
Reports 

124 EII # 131965 To display the flag icons or the total count of 
flags in the All Flags and Reception Flags 
columns using the configuration key settings in 
the Reception/Front Desk screen. 

Reception 

126 EII # 131989 RWQM Updates: Implementing DOS From and 

DOS To filer: Front End 

RWQM 

127 EII # 132017 RWQM Updates: Implementing DOS From and 

DOS To filer: Back End 

RWQM 

128 EII # 130484 Changes are implemented to display the Client 
Order diagnosis codes under ‘Dx/Purpose’ 
dropdown in the ‘Complete Medication Order’ 
page. 

Rx Application 

138 EII # 131703 Changes are implemented to display the Core 
Header and Footer in the Scanned and 
Uploaded documents. 

Scanning 

141 EII # 129487 A  new configuration key has been introduced 
to evaluate service completion lag days based 
on both the Created Date and Completion 
Date. 

Services 

149 EII # 131811 To display Sensitive Information section based 
on the value set in 
DisplaySUDCheckboxToTagDataAsSUD 

Services/Notes 
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configuration key and Note tab visibility for  
service note (SUD related) 
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TASKS LIST-‘NEW FUNCTIONALITY’ (2) 

Sl. No Task No Summary Module Name 

105 EII # 129610 Implementation of a new ‘UDS Table 6B 
Details- Section N - Initiation and Engagement 
of Substance Use Disorder Treatment 
(CMS137v13)’ -FOR 2025 Reporting Year. 

My Reports/UDS 
Reports 

117 EII # 132223 Implementation of ‘Staff 3PL Update Report’. My Reports/UDS 
Reports 

 

Functionality Task Details 

Activity Tracker  

Reference No Task No Description 

1 EII # 130398 Restricting Future Activity Updates 

EII # 130398: Restricting Future Activity Updates 

What’s changed: 

• Implemented a restriction to prevent staff from entering or updating details for activities 
scheduled with future start dates. 

• New validation message displays when attempting to open such activities: 
 “The activity you have chosen is scheduled for a future Start Date and cannot be updated at this 
time.” 

• All fields in the Flow Sheet Detail pop-up are disabled except Cancel and Close (X). 

• Validation message stored in the ApplicationMessages table. 

Where to find it: 

• Path 1: Client → Client Activity Tracker → Select Future Start Date → Apply Filter → Open 
Activity. 

• Path 2: My Office → My Client Activities → Select Future Start Date → Apply Filter → Open 
Activity. 

How it helps: 

• Maintains data integrity by ensuring only valid, completed activities can be updated. 

• Eliminates risk of premature or inaccurate activity entries. 

• Provides clear system feedback through validation messaging. 

Notes: 

• Active change (new restriction applied automatically). 

• Requires a signed Client Order of “Activity” type. 

Adhoc Reporting 
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Reference No Task No Description 

2 EII # 130184 MCO tables are included in the Adhoc Reporting. 

3 EII # 130887 MCO tables are included in the Adhoc Reporting- SQL 

View 

EII # 130184: MCO tables are included in the Adhoc Reporting. 

What’s changed: 

The Adhoc Reporting screen has been updated to include MCO tables under the Catalogs section, 
allowing users to build and run queries using MCO-specific entities and attributes. 

Previously, the ‘MCO’ option was not available in the Catalogs dropdown. With this release, users can 
now select MCO as a catalog type and access a dedicated section for MCO Entities and Attributes, 
enhancing reporting flexibility and coverage. 

Where to find it: 

Path: 
My Office → Adhoc Reporting → Adhoc Reporting Screen 

How it helps: 

• Adds ‘MCO’ to the Catalogs dropdown 

• Replaces default Entities and Attributes section with MCO - Entities and Attributes 

• Displays related sub-tables when a main MCO table is selected 

• Enables users to build queries using existing Adhoc Reporting functionality 

Label Updates: 

Standardized UI labels for consistency: 

• ‘Result columns’ → ‘Result Columns’ 

• ‘Column sorting’ → ‘Column Sorting’ 

• ‘Query conditions’ → ‘Query Conditions’ 

• ‘Entities and attributes’ → ‘Entities and Attributes’ 

Available MCO Entities and Attributes: 

• Adjudications 

• BillingCodes 

• Checks 

• ClaimApprovalOverrides 

• ClaimBundles 

• ClaimDenialOverrides 

• Claims 

• Contracts 

• Credentialing 

• Events 

• Import837Files 

• Insurers 

• ProviderAuthorizations 

• Providers 

• Sites 

Notes: 

Complements EII #130877 (SQL View support for MCO tables) 
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EII # 130887: MCO tables are included in the Adhoc Reporting- SQL View 

What’s changed: 

Support for MCO tables has been extended to SQL Views within Adhoc Reporting, enabling more 
advanced and flexible reporting capabilities. 

Previously, MCO tables were not available for use in SQL-based Adhoc Reporting. With this release, 
users can now create SQL Views using MCO entities, allowing for deeper data analysis and custom 
reporting logic. 

Where to find it: 

Not applicable — SQL Views are configured at the backend and do not have a front-end navigation path. 

How it helps: 

• Expands Adhoc Reporting functionality to include MCO data 

• Enables creation of custom SQL Views using MCO entities 

• Supports more flexible and powerful reporting scenarios 

Notes: 

• Active change (backend configuration required) 

• Dependent on EII #130184, which introduced MCO tables in the front-end Adhoc Reporting 
Catalogs 

Appointment Search 

Reference No Task No Description 

6 EII # 131826 Appointment Search: Added new icon to advance the 

search to the next 15 days. 

EII # 131826: Appointment Search: Added new icon to advance the search to the next 15 

days. 

What’s changed: 

A new enhancement has been added to the Appointment Search screen to streamline the process of 
viewing upcoming appointments. Users can now quickly advance the search window by 15 days using a 
newly introduced icon, eliminating the need for manual date entry. 

Key Updates: 

• Added a Next 15 Days icon next to the Search button 

• Automatically updates the appointment date range 

• Improves efficiency and reduces user error 

How It Works: 

New Icon Behavior 

• Location: Next to the Search button 

• Tooltip: 
“This button allows users to search appointments for next 15 days after the currently selected 
Appt. To Date.” 

Date Range Update Logic 

On Click: 

• Appt. From: Set to one day after the current Appt. To date 

• Appt. To: Set to 15 days after the new Appt. From date 
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Example: 
If current range is: 

• Appt. From = 06/01/2025 

• Appt. To = 06/15/2025 
After clicking the icon: 

• Appt. From = 06/16/2025 

• Appt. To = 06/30/2025 

Auto-Adjustment Logic 

• If Appt. From is updated and range exceeds 15 days → Appt. To is adjusted to maintain a 15-day 
window 

• If Appt. To is updated and range exceeds 15 days → Appt. From is adjusted (but not earlier than 
current date) 

• If range is already within 15 days → No adjustment occurs 

UI Updates 

Filters such as Search for Client, Unable to Offer a Timely Appt., and Search have been rearranged to 
accommodate the new icon 

Where to find It: 

Path: 
My Office → Appointment Search → Appointment Search list page → Use the new icon next to the 
Search button to advance the date range 
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Batch Eligibility 

Reference No Task No Description 

8 EII # 131750 To implement the logic, change in 270/271 eligibility 

record days in the past and days in the future. 

9 EII # 131752 To implement the change in the logic of 270/271 eligibility 

record days in the past and days in the future 

EII # 131750: To implement the logic, change in 270/271 eligibility record days in the past 

and days in the future. 

What’s changed: 

A new configuration option has been added to the Batch Eligibility Configurator to support automatic 
eligibility date logic for the current month. This enhancement simplifies setup and improves accuracy by 
allowing users to define eligibility service dates based on the first and last days of the current month. 

Key Updates: 

• Introduced Monthly Eligibility Check checkbox 

• Automatically sets service date range to span the full current month 

• Disables manual date range fields when selected 

• Supports mutual exclusivity between monthly logic and custom date ranges 

How it works: 

New Field Added 

• Field Name: Monthly Eligibility Check 

• Location: General tab → Batch Eligibility Records section 

• Tooltip: 
“Checks eligibility for the full current month, from the 1st to the last day.” 

Field Behavior 

When Monthly Eligibility Check is selected: 

• # of Days in the Past and # of Days in the Future fields are disabled 

When either of those fields is populated: 

• Monthly Eligibility Check is disabled 

Backend Logic 

If Monthly Eligibility Check is selected and saved: 

• A row is added to the ElectronicEligibilityVerificationConfigurationFeatureDetails table 
with: 

 ConfigurationName: UseServiceDatesStartAndEndOfCurrentMonth 

 CharacterValue: Yes 

 IntegerValue: NULL 

If the checkbox is later unchecked: 

• CharacterValue is updated to No 

Mutual Exclusivity 

If values are entered in # of Days in the Past or # of Days in the Future: 
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System updates: 

• NumberOfDaysBackForBatch 

• NumberOfDaysForwardForBatch 

• UseServiceDatesStartAndEndOfCurrentMonth is set to NULL 

Where to find It: 
Administration → Batch Eligibility Configurator List → Click New → Batch Eligibility Configurator 
Details screen → General tab → Batch Eligibility Records section 

EII # 131752: To implement the change in the logic of 270/271 eligibility record days in the 
past and days in the future 

What’s changed: 

• New Monthly Eligibility Check option added to Batch Eligibility Configurator. 

• When enabled, the system automatically sets Eligibility Start Date to the first day of the current 
month and End Date to the last day of the current month. 

• Overrides the prior logic that relied on “# of Days in the Past” and “# of Days in the Future” fields 
(previous default = 0). 

Where to find it: 
 Administration → Batch Eligibility Configurator List → New → Batch Eligibility Configurator Details → 
General tab → Batch Eligibility Records → Monthly Eligibility Check checkbox. 

How it helps: 

• Automates monthly eligibility range setup. 

• Eliminates manual configuration of past/future day offsets. 

• Ensures consistency across batch eligibility runs. 

Notes: 

• Passive change (no extra setup beyond enabling the checkbox). 
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Charges/Claims 

Reference No Task No Description 

120 EII # 130767 Travel Line Configuration: Implementing a front-end 

configuration to allow SV101-07 procedure code 

descriptions for 837P claim files, supporting accurate 

service line billing. Front-end implementation. 

15 EII # 130766 Travel Line Configuration: Implementing a front-end 

configuration to allow SV101-07 procedure code 

descriptions for 837P claim files, supporting accurate 

service line billing. Back End changes implementation. 

EII # 130767: Travel Line Configuration: Implementing a front-end configuration to allow 

SV101-07 procedure code descriptions for 837P claim files, supporting accurate service 

line billing. Front-end implementation. 

What’s changed: 

Updated the front-end UI to support inclusion of SV101-07 procedure code descriptions within the 
Procedure/Rate setup, Plan Details, and Claim Provider Override screens. 

Renamed the label “Rev Code Description” to “Code Description” across all relevant screens to 
eliminate confusion and support accurate billing for CPT, HCPCS, and travel line codes. Added new UI 
elements to enable direct configuration and visibility of code descriptions without manual claim edits. 

Where to find it: 

• Path 1: Existing Procedure Code Details Screen 
Administration → Procedure/Rates → New → Procedure Code Details 
→ General tab → Enter details 
→ Rates/Billing Codes tab → Standard Billing Code section 
→ Enter Code Description → Advanced Billing Code pop-up → Enter Code Description 
→ View Code Description column in Rate List grid 

• Path 2: New Procedure Code Details Screen 
Same as above, but uses Add Rates button to open Rates/Standard Billing Codes pop-up 

• Path 3: Plan Details Screen 
Administration → Plans → General tab → Enter details → Save 
→ Value Codes tab → Enter Code Description → View in Value Codes list 
→ Billing Codes tab → Select “Use this Plan as Template” → Save 
→ Procedure hyperlink → Plan Billing Code pop-up → Enter Code Description 
→ Advanced Billing Code pop-up → Enter Code Description 

How it helps: 

• Enables accurate configuration of procedure code descriptions for 837P claims 

• Supports billing for travel lines without manual claim edits 

• Improves clarity by replacing outdated “Rev Code Description” label 

Notes: 

• Active change (visible in front-end UI) 

• No changes to the data model 

• Works in conjunction with EII #130766 (back-end implementation for SV101-07) 
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EII # 130766: Travel Line Configuration: Implementing a front-end configuration to allow 
SV101-07 procedure code descriptions for 837P claim files, supporting accurate service 
line billing. Back End changes implementation. 

What’s changed: 

Additional logic has been implemented to support accurate behavior when using the 
837PClaimCodeDescription configuration key and customizing Claim Format Overrides. These 
updates ensure flexible and reliable population of SV1-07 procedure code descriptions in the 2400 loop 
of 837P claim files. 

How it works: 

Configuration Key Behavior: 

• Invalid Values: 
If the configuration key is set to any value other than Yes or No, the system defaults to No 
behavior — SV1-07 code descriptions will not be populated. 

• Null Code Descriptions: 
If the key is set to Yes but the code description field is blank, the SV1-07 segment is excluded 
from the claim. 

• Claim Format Overrides: 
o Override Sources: 

Code descriptions can be populated from: 
▪ Standard Billing Code 
▪ Plan Billing Code 
▪ Other (Freeform Textbox) 

• Freeform Textbox Null Behavior: 
If the Other data source is selected and the textbox is left blank, the SV1-07 segment will not be 
populated. 

• Override Independence: 
Claim format overrides function with or without the configuration key being set to Yes. 

• Visual Configuration Examples: 
o Format Field: 2400 – SV1 – 07 Description 
o Data Source Options: Standard Billing Code, Plan Billing Code, Other 
o Data Value: Code Description or freeform text 

Notes: 

• Passive change (no customer action required to enable) 

• Complements EII #130767 (front-end UI support for code descriptions) 
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Client Flags 

Reference No Task No Description 

24 EII # 130941 Implementation to convert the "Client is an Adult with 

Guardian" icon a Client Flag. 

EII # 130941: Implementation to convert the "Client is an Adult with Guardian" icon a 

Client Flag. 

What’s changed: 

The “Client is an Adult with Guardian” icon has been replaced with a configurable Client Flag, allowing 
for standardized and flexible display of guardianship status. 

Key Updates: 

• Converted hardcoded icon into a Client Flag: Adult Client with Guardian 

• Flag can be managed through standard Client Flag configuration settings 

• Automatically created for qualifying clients based on age and contact type 

How it works: 

Flag Behavior 

• Flag Type: Adult Client with Guardian 

• Flag Level: Information 

• Display Date: Date the flag is created 

• End Date: Date the flag is deactivated 

• Flag Note: Automatically generated when: 
o Client age exceeds the threshold set in SetMaxAgeToIdentifyClientAsMinor 
o Client has a contact marked as Guardian or Legal Guardian 

• Default State: Inactive 

• Display Locations: 
o Client Flag List Page 
o Client Hover section (next to Client Name/ID) 

Where to find It: 

• Path 1: 
Client Search → Select Client → Client Information → Contacts tab → Add contact as “Guardian” 
or “Legal Guardian” → Save 

• Path 2: 
Select Client → Client Flags → “Adult Client with Guardian” flag is available 

How It Helps: 

• Standardizes guardianship status using configurable flags 

• Improves flexibility for managing, deactivating, or customizing flag behavior 

• Enhances visibility of client context across workflows 

Notes: 

Passive change (no customer action required) 

Client Orders  

Reference No Task No Description 
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33 EII # 127274 To enable Client Order screens to auto-calculate total 

dose and to trigger weight-based overdose alert requiring 

prescriber acknowledgment. 

34 EII # 127483 Implementation of Lifestream Titration templates / 

favorites.  

35 EII # 129496 PC: SmartCare to send an alert to a Prescriber when a 

nurse discontinues a medication order in SmartCare 

Orders.  

36 EII # 131718 Implementation of Queue PDF Generation/Render 

Process for Client Orders.  

55 EII # 132077 Added ‘Do Not Render PDF Immediately’ checkbox for 

‘Client orders’ in the Document Codes Detail screen.  

EII # 127274: To enable Client Order screens to auto-calculate total dose and to trigger 

weight-based overdose alert requiring prescriber acknowledgment. 

What’s changed: 

Enhancements have been made to the Weight-Based Calculator and Client Order workflow to support 
improved dosing accuracy, streamlined user experience, and compliance with recommended dosage 
guidelines. 

Key Updates: 

• Introduced Min/Max Daily Range display sourced from First Databank (FDB) 

• Added automated flow sheet integration for weight updates 

• Implemented dose validation logic with alert and acknowledgement workflow 

• Enabled audit tracking for high-dose overrides 

• Updated data model to support new functionality 

How it works: 

Min/Max Daily Range Display 

• Field: Min/Max Daily Range (read-only) 

• Logic: System pulls recommended ranges from FDB 

• Behavior: For pediatric clients (<18 years), only the range matching the client’s age in days is 
shown 
Example: A client aged 750 days will see the range labeled 600–850 days 

Apply Button Behavior 

• Triggered When: Weight is modified 

• Actions: 

 Creates a new Core Vitals Flow Sheet entry with current date/time 

 Pushes updated weight (lb, kg, oz) to flow sheet 

 Updates Client Order screen fields: 

 Dose: Calculated as 
Dose×kg÷Times Per Day=Units per DoseDose×kg÷Times Per Day=Units per 
Dose 

 Frequency, Days, Refills: Pulled from popup selections 

 Note: If weight is unchanged, no flow sheet entry is created 

Reset Button Behavior 

• Clears all fields in the popup except: 
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 Weight 

 Dose 

Dose Validation & Alert Logic 

• Trigger: Clicking Insert/Modify in Client Order screen 

• Validation: 

 Checks for FDB Max Daily Dose Strength 

 Uses most recent weight from Core Vitals Flow Sheet 

 Calculates Daily Dose Amount: 
(DoseWeight in kg)×Times Per Day(Weight in kgDose )×Times Per Day 

Outcomes: 

• If within range: Medication inserted without alert 

• If exceeded: Dose Acknowledgement popup appears 

Dose Acknowledgement Popup 

• Message: 
“One or more of the Doses you are attempting to Insert exceeds the Recommended Max Daily 
Dose Strength.” 

• Field: Acknowledge and Proceed (checkbox) 

• Behavior: 

 Checkbox must be selected to enable OK button 

 Clicking OK inserts medication into Order List grid 

 On signing, audit log captures: 

 User identity 

 Timestamp 

 Acknowledgement of high dosage 

• Cancel (X Button) Behavior 

 Returns user to previous screen 

 Medication is not inserted into Order List grid 

Where to find It: 

Path: 
Client Orders → Open Weight-Based Calculator → Modify weight/dose → Click Apply or Insert → 
Follow alert and acknowledgement workflow as needed 

Data Model Changes 

• DoseAcknowledgeBy column added to ClientOrders table 

• ShowDoseCalculator column added to OrderStrengths table 

 

EII # 127483: Implementation of Lifestream Titration templates / favorites. 

What’s changed: 

The Order Sets screen has been enhanced to support Titration/Taper templates and favorites, allowing 
users to create reusable multi-step medication orders. 

Previously, users had to manually enter each step of a taper/titration order for every client. With this 
release, users can define multi-step orders in advance and apply them across clients with full support for 
frequency logic, dispense timing, and validation—streamlining workflows and improving consistency. 

Where to find it: 
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• Path 1: Create Frequency 
Admin → Order Template Frequency → New → Set “Use Start Time of Order as First Dispense 
Time” → Save 

• Path 2: Create Medication Order 
Admin → Orders → New → Select frequency → Set “Titration/Taper?” = Yes → Save 

• Path 3: Build Order Set 
Admin → Order Sets → New → Add medication order → Set Default → Add Steps → Save 

• Path 4: Apply to Client 
Client → Client Orders → New → Order Set tab → Select Order Set → Save & Sign 

• Path 5: Manual Entry Option 
Client → Client Orders → New → Orders tab → Add steps manually → Save & Sign 

• Path 6: Verify in MAR 
Client → Client MAR → Filter → Verify signed order and steps 
My Office → Group MAR → Filter → Verify signed order and steps 

How it helps: 

• Enables reusable multi-step medication orders for tapering regimens 

• Reduces manual data entry and improves consistency across clients 

• Supports frequency logic and dispense timing for accurate scheduling 

Functionality: 

• Order Set Defaults Pop-Up: 
o Add Steps: Pre-populates values (except Dose, Day Supply, Frequency, Start) 
o Delete Steps: Removes latest step; disabled if only one step exists 
o Frequency Filtering: Subsequent steps show only matching frequency types 
o Start Dropdown: Options limited to “Today” and “Other”; defaults to “Other” after first 

step 
o Multiple Steps Indicator: Displays “Yes” or “No” based on step count 

• Client Order Screen Behavior: 
o Standing Order Checkbox: Disabled for taper/titration orders 

• Start Date/Time Calculation: 
o 1 day supply = 24 hours 

▪ Example: Start 9/10/2025 2:00pm → End 9/11/2025 1:59pm 
▪ Subsequent steps auto-calculate based on previous step’s end 

• End Date/Time Visibility: 
o Hidden for steps beyond the first 
o Displayed in PDF after signing 

• Medication Name Display: 
o Multi-step: Abilify FDTS (Abilify) – Multiple Steps 
o Single-step: Alive Max3 Potency start date (Alive Max3 Potency) 

• Frequency Dropdown Logic: 
o Mapped Frequencies: 

▪ First step shows mapped values from Order Setup 
▪ Subsequent steps filtered by frequency type 

• Unmapped Frequencies: 
o First step pulls from Order Template Frequency 
o Subsequent steps filtered based on first step’s selection 

• Validation Messages: 
o Displayed if frequency types mismatch across steps 
o “Step 1 and Step 2 have mismatched frequency settings.” 
o “Frequency type 'Start time as first dispense time' cannot be placed with any other 

frequency types.” 

• Titration/Taper Button: Hidden when Order Set is selected 

Client MAR & Group MAR Functionality: 
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• Dispense Timing Logic: 
o 1 day supply = 24 hours 
o Next step starts based on last dispense time of previous step 
o Example Schedule: 

▪ Step 1: Q4H → Dispenses every 4 hours 
▪ Step 2: Q6H → Dispenses every 6 hours starting from last dispense of Step 1 

• Display: 

• Signed multi-step orders appear in both Client MAR and Group MAR 

• Medication and step details are shown clearly 

 

EII # 129496: PC: SmartCare to send an alert to a Prescriber when a nurse discontinues a 
medication order in SmartCare Orders. 

What’s changed: 

• Introduced alerts to notify Prescribers when a nurse discontinues a medication order in 
SmartCare Orders. 

• New Discontinued Order popup displays when a nurse (non-prescriber) discontinues a 
medication order and the Prescriber has enabled Notify If Medications are Discontinued in My 
Preferences → Check-In Notification Preferences. 

• Popup includes a checkbox “Alert Ordering Prescriber of Discontinued Order”; if checked, an 
alert is sent to the Prescriber when the order is signed. 

• Alert includes client details, medication name/strength, and date/time. Appears under the 
Notification icon and in the Alerts list. 

Where to find it: 

• Path 1: My Office → My Preferences → Check-In Notification Preferences → Notify If 
Medications are Discontinued. 

• Path 2: Client → Orders → New → Select Medication Order → Insert/Modify → Discontinue → 
Sign (Nurse staff). 

• Path 3: My Office → Alerts. 

How it helps: 

• Ensures Prescribers are proactively notified when medications are discontinued by nursing staff. 

• Reduces risk of missed changes in client medication plans. 

• Provides Prescribers with a clear alert message containing patient and medication details for 
immediate review. 

Notes: 

• Passive change (requires enabling checkbox in Preferences). 

• Popup does not display if: 

 Discontinue box is unchecked. 

 Discontinue box is checked but logged-in staff is the Prescriber. 

 Prescriber’s Notify If Medications are Discontinued preference is not enabled. 

Data Model Changes: 

• Added column NotifyPrescriberOnDiscontinuedOrder in ClientOrders table. 
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EII # 131718: Implementation of Queue PDF Generation/Render Process for Client Orders. 

What’s changed: 

A queue-based PDF generation process has been implemented for Client Orders, introducing a new 
configuration option—Do Not Render PDF Immediately—in the Document Codes Details screen. This 
enhancement improves performance and user flexibility by allowing PDF rendering to occur in the 
background after signing. 

Key updates: 

• Added Do Not Render PDF Immediately checkbox to Client Orders configuration 

• Enables delayed PDF rendering via background processing 

• Displays confirmation message with optional View PDF button 

• Temporarily restricts certain actions until PDF is generated 

How it works: 

• If Do Not Render PDF Immediately = Checked 

 PDF Generation: 

• Signed Client Orders are queued for background PDF rendering 

• Confirmation Message: 
“The document has been signed successfully. You may continue your work while the 
PDF is being processed. Alternatively, if you wish to view the PDF now, you can click 
on the 'View PDF' button.” 

• Optional Action: 
Author may click View PDF to render it immediately 

• Access Restrictions: 
Until PDF is generated, Client Viewing, Co-Sign, and Decline actions are disabled 

• Message for Other Users: 
“The document signed by the author is queued. You can wait until the PDF is ready 
to be rendered to review it before signing.” 
(No View PDF button shown) 

• Background Job: 
Runs every 15 minutes to process queued PDFs 

• If Do Not Render PDF Immediately = Unchecked 

 PDF is rendered and displayed immediately upon signing (existing behavior) 

Where to find It: 

• Path 1: 
Administration → Document Codes → Client Orders → Document Codes Details → 
Document Section → Select Do Not Render PDF Immediately 

• Path 2: 
Client → Client Orders → Enter all details → Sign 

How it helps: 

• Reduces system load during signing 

• Improves performance for large documents 

• Allows staff to continue workflow without waiting for PDF generation 

 

EII # 132077: Added ‘Do Not Render PDF Immediately’ checkbox for ‘Client orders’ in the 
Document Codes Detail screen.  
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What’s changed: 

A new checkbox—Do Not Render PDF Immediately—has been added to the Client Orders document 
configuration in the Document Codes Detail screen. This enhancement introduces queue-based PDF 
generation, improving system performance and user flexibility, especially for large documents. 

Key updates: 

• PDF generation now occurs in the background, allowing users to continue working without delay 

• New checkbox controls downstream document rendering behavior 

• Related fields are automatically disabled when the checkbox is selected 

How it works: 

New Checkbox Added 

• Field Name: Do Not Render PDF Immediately 

• Location: Document section of the Client Orders document in the Document Codes Detail 
screen 

• Default State: Unchecked 

Behavior When Checked 

The following fields in the Details section are automatically set to No and disabled: 

• Recreate PDF On Client Signature 

• Requires Licensed Signature 

• Regenerate RDL On CoSignature 

When the checkbox is unchecked, these fields are re-enabled and remain set to No 

Scope 

This checkbox is only available for the Client Orders document 

Where to find it: 
Administration → Document Codes → Search for Client Orders → Open Document Codes Detail 
screen 

Data Model Changes 

DoNotRenderPDFImmediately column added to the DocumentCodes table 

Configuration Keys 

Reference No Task No Description 

45 EII # 128533 Added Module and Screen Details for few existing 
configuration keys 

EII # 128533: Added Module and Screen Details for few existing configuration keys 

What’s changed:  

The Configuration Key Details screen has been enhanced to improve visibility, traceability, and user 
navigation. This update introduces Module and Screen information for a wide range of existing 
configuration keys, helping administrators better understand the functional context of each key. 

How it helps 

Previously, many configuration keys lacked associated module and screen details, making it difficult to 
determine where and how they were applied. With this release, those gaps have been addressed, 
streamlining system configuration management. 

Key Enhancements 
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• New Fields Added 
o Module: Displays the name of the module linked to the configuration key. 
o Screen: Shows the screen name where the key is applied. 

• The screen name is now a clickable hyperlink. 

• Clicking the hyperlink redirects to the Configuration Keys List page, filtered by the selected 
screen. 

Functionality 

• Module field correctly displays associated module names. 

• Screen field accurately shows screen names as hyperlinks. 

• Hyperlinks redirect to the filtered Configuration Keys List page. 

• Configuration keys are correctly linked to their respective documents. 

Updated Configuration Keys 

The following configuration keys now include Module and Screen details: 

• ASSESSMENTDOCUMENTCODEID 

• SetDurationForCoreCarePlanEndDate 

• SetNumberValueToCalculateEndDateForAddendumCarePlan 

• RefreshCarePlanMasterData 

• SetReviewInCarePlan 

• SHOWORGANIZATIONNAMEONCAREPLANRDL 

• ShowAdditionalTimeAndDurationInCarePlanIntervention 

• SetInterventionTabAndSectionNameForISPAndISPMCOEvents 

• UseBTATemplateForGoalsAndObjectivesInCarePlan 

• ShowMHAssessmentRefreshButtonOnTreatmentPlan 

• CarePlanUseCustomGoalInitialization 

• HideSelectedFieldsInGoalsAndTreatmentProgramTabsOfTreatmentPlan 

• SetDurationForISPInitialization 

• EnableReviewDateForAddendumInISP 

• SetChosenNameForISPDocument 

• SetInitializationOfCarePlanVarybyProgram 

• INTIALIZETREATMENTEAMCP 

• ShowValidationForHowManySessionsInCarePlanInterventions 

• AssessmentToInitalizeFromPreviousEpisode 

• SetNumberofMonthsToInitializeHistoryofPresentingProblem 

• CreateAuthWhenAddingInterventions 

• ISPMCORequireProvider 

Where to find it 
Administration → Configuration Keys → Select a configuration key → View Configuration Key Details 
screen 
(e.g., EII #129476) 

Contact/Referrals 

Reference No Task No Description 

46 EII # 130964 Implemented a new section ‘Needs This Organization 

Addresses’ and ‘Contacts’ in ‘Contact/Referral 

Organization’ screen. 

EII # 130964: Implemented a new section ‘Needs This Organization Addresses’ and 

‘Contacts’ in ‘Contact/Referral Organization’ screen. 
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What’s changed: 

The Contact/Referral Organization screen has been enhanced with two new sections: 

1. Needs This Organization Addresses 
2. Contacts 

These additions expand the existing functionality (previously only a General section) and support Care 
Coordination workflows by allowing users to: 

• Search organizations that provide services for specific needs. 

• Search organizations by staff contact names. 

Where to find it:  

Contact/Referral Organization List → New → Contact/Referral Organization Details 

New Functionality 

1. Needs This Organization Addresses 

• Instruction label guides users on purpose (CCBHC Care Coordination). 

• Fields: 

 Need Domain (type-ahead search; alphabetical list) 

 Identified Need (type-ahead search; filtered by selected domain) 

• Validation messages: 

 Required fields must be selected before insertion. 

• Grid features: 

 Displays Domain + Need names. 

 Buttons: Insert, Modify, Clear. 

 Options: Delete (X), Modify. 

2. Contacts 

• Instruction label clarifies usage in Care Coordination. 

• Fields: 

 Contact Name (placeholder: Last Name, First Name; required) 

 Contact Email (valid email format required) 

• Validation messages: 

 Required field if name is missing. 

 Duplicate contact name not allowed. 

• Grid features: 

 Displays Contact Name + Email. 

 Buttons: Insert, Modify, Clear. 

Data Model Changes 

• New Tables: 

 ContactReferralOrganizationDomainNeeds 

 ContactReferralOrganizationContacts 
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Core Assessment 

Reference No Task No Description 

47 EII # 131829 Suicide Risk Assessment: Space issue in PDF 

48 EII # 131920 Core Assessment initialization logic has been 

implemented for the 'Borderline Symptom List (BSL-23)' 

document which is added as tab. This tab's data will be 

initialized based on the client’s Episode, using the existing 

system configuration key 

‘AssessmentToInitializeFromPreviousEpisode’. 

EII # 131829: Suicide Risk Assessment: Space issue in PDF 

What’s changed: 

A formatting issue in the Suicide Risk Assessment PDF output has been resolved to improve document 
readability and layout consistency. 

Key updates: 

• Optimized PDF rendering for assessments containing multiple tab types 

• Removed excess blank space caused by dynamic content 

• Ensures a clean, professional layout across all assessment formats 

How it works: 

PDF Output Optimization 

Applies to Core Assessment documents containing: 

• Static tabs 

• Dynamic tabs 

• DFA tabs 

• Non-DFA tabs 

System now removes unnecessary white space during PDF generation 

Layout is compact and consistent regardless of tab configuration 

Where to find it: 
Search → Create or select a client → Document Codes → Select Assessment (C) 
Assessment tab → Select Assessment Group → Choose tab (e.g., Psychosocial Adult) 
Select Assessment Type, Age Category, and Population Type → Click Insert → Save 
Go to Assessment (C) → Enter required fields → Save → Sign → View PDF 

How it helps: 

• Eliminates clutter in PDF output 

• Improves readability and professional appearance 

• Applies universally across all tab types used in assessments 

 

 

EII # 131920: Core Assessment initialization logic has been implemented for the 
'Borderline Symptom List (BSL-23)' document which is added as tab. This tab's data will 
be initialized based on the client’s Episode, using the existing system configuration key 
‘AssessmentToInitializeFromPreviousEpisode’. 
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What’s changed: 

• Added Borderline Symptom List (BSL-23) as a tab in Core Assessment. 

• Tab data now initializes based on the client’s Episode, using existing system configuration key 
AssessmentToInitializeFromPreviousEpisode. 

• Initialization pulls from the most recently signed Standalone or Assessment document within 
the same Episode (not across all episodes). 

Where to find it: 
Client Search → Assessment (Core) → enter data in tabs → Sign → New → verify initialization from 
previously signed document. 

Prerequisites: 

1. Document Mapping: Ensure BSL-23 is marked Active in Document Mapping screen. 
2. Document Codes Setup: Activate BSL-23 under Document Codes → Assessment (Core) → 

Assessment Tab → Tab Triggers. Define Type, Age Category, Population, Assessment 
Classification, and select Active. 

3. Confirm BSL-23 tab is available in Core Assessment setup. 
4. A client Episode must exist. 

How it helps: 

• Ensures BSL-23 data is episode-specific, improving accuracy of carried-forward assessments. 

• Aligns behavior with other tabs configured for episode-based initialization. 

Notes: 

• Passive change (no customer action required beyond prerequisites). 

• Available only to customers with a paid annual subscription (premium add-on; not part of base 
SmartCare subscription). 

• Related to prior work in EII #130690 (released in 6.0_1-May MSP_2025, Build 
SC.CORE.6.0_1.34.000.2505.011). 

Documents 

Reference No Task No Description 

56 EII # 130321 Implemented a warning message to users when the 
logged-in staff is not authorized to author a document. 

57 EII # 130801 NOMS Document Updates - 2025 

107 EII # 130802 NOMS File Mapping and List page Updates 

58 EII # 131639 Implementation of alert message stating "System failed 
to generate the pdf" will be sent to staff and author. 

59 EII # 131753 Change in ‘Consent to Share Health Information’ 
document 

EII # 130321: Implemented a warning message to users when the logged-in staff is not 
authorized to author a document. 

What’s changed: 
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• Added a warning message when a logged-in staff member is not authorized to author a 
document. 

• Triggered when the “Can Author/Proxy SmartCare Document” checkbox is unchecked in 
Staff Details. 

Where it appears: 

• When staff attempts to create a new document. 

• When staff opens any in-progress document. 

Warning Message: 

“The Logged In staff is not permissioned to be the author of any documents. Please review before you 
proceed.” 

How it helps:  

• Improves clarity in the Author dropdown experience. 

• Helps staff recognize authorization restrictions before proceeding. 

Other details: 

• Passive Change (no customer action required) 

 

EII # 130801: NOMS Document Updates - 2025 

What’s changed: 

• Updated the Core National Outcome Measures (NOMs) document used to report and track 
client assessment details. 

• Several fields were removed, reworded, or newly added across different tabs. 

• A new database table, DocumentNOMSDemographics, has been introduced. 

Where it appears: 

• My Office → My Works → My Documents → National Outcome Measures Document 

How it helps:  

• Keep NOMs documentation current for 2025 standards. 

• Improve clarity, consistency, and alignment with reporting requirements. 

1. Fields Removed 

• Demographics Tab: 

 “What do you consider yourself to be? (Specify)” 

 “Do you think of yourself as... (Specify)” 

• Program-Specific Questions – G4 (Minority AIDS Service Integration): 

 Q5. “Have you been prescribed an Antiretroviral Medication (ART)?” 

 Q5a. Follow-up on ART adherence. 
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2. Verbiage Changes 

• Records Management Tab: 

 Suicide screen question wording updated. 

• Functioning Tab: 

 Reworded questions about feelings in the past 30 days. 

• Perception of Care Tab: 

 Clarified language around rights, responsibilities, and confidentiality. 

• Program-Specific Questions – G4 (Minority AIDS Service Integration): 

 Revised HIV, HBV, and HCV testing/treatment questions. 

• Program-Specific Questions – G7 (Clinical High Risk for Psychosis): 

 Updated psychosis episode question wording. 

3. New Fields Added 

• Demographics Tab: 

 “What is your sex?” 

• Program-Specific Questions – G4 (Minority AIDS Service Integration): 

 PrEP/HIV treatment use. 

 HIV, HBV, and HCV testing history. 

 Hepatitis A & B vaccination offers and referrals. 

4. Dropdown Value Updates 

• Removed from ‘Other’ options (Program-Specific G2 — Law Enforcement & Behavioral 
Health Partnerships): 

 Follow-up service receipt questions for mental health and substance use. 

Other details: 

• Active Change (affects client-facing workflows) 

Data Model Change: Added new table DocumentNOMSDemographics. 

EII # 130802: NOMS File Mapping and List page Updates 

What’s changed: 

• Updated the Core NOMs file mapping and reporting list page used to track and submit 
assessment details. 

• Several fields were removed, reworded, newly added, or defaulted to blank values in both 
the CSV export and NOMS Details page. 

• Database changes were made to support new reporting requirements. 

Where it appears: 

• Path 1: My Office → My Works → NOMS Reporting List Page → Click Record ID → NOMS 
Reporting Details Page. 

• Path 2: My Office → My Works → NOMS Reporting List Page → Select Record ID → Create 
Batch Submission → CSV file generated to configured SFTP path. 

How it helps:  
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• Align NOMs reporting with 2025 standards. 

• Improve accuracy of exported CSV data and streamline submission. 

1. Fields Removed 

Removed from both CSV file and NOMS Details page: 

• Gender 

• GenderOtherSpec 

• SexualIdentity 

• SexualIdentityOtherSpec 

• HIVARTMedication 

• HIVARTMedicationFreq 

2. Verbiage Changes 

Field labels updated for consistency: 

• HIVTestResultRecent 

• HBVTestResultRecent 

• HCVTestResultRecent 

3. Newly Added Fields 

Added to both CSV file and NOMS Details page: 

• Sex 

• HIVPrevention 

• HIVEverTested 

• HIVTestServicesWithin30 

• HBVEverTested 

• HBVTreatmentServices 

• HCVEverTested 

• HCVTreatmentServices 

• ReferralOut 

• HepABVaccinationOffer 

• ReferralVaccination 

4. Fields Defaulted to Blank 

Numerous reporting and service fields are now set with blank default values in both CSV file and NOMS 
Details page. 
Examples include: 

• MedicationAsPrescribed, TreatmentCompliant 

• ClientRef/ClientRecd Mental Health & SUD Services (G2, G5) 

• Multiple physical health measures (BP, weight, labs) 

• Various service tracking items (screening, case management, housing, transportation, etc.) 

• Discharge fields (Date, Status, OtherDischargeStatus) 
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Other details: 

• Active Change (affects client-facing workflows) 

Data Model Change: New columns added to NOMSSPARSCandidateDataSet: 

 Sex, HIVPrevention, HIVEverTested, HIVTestServicesWithin30, HBVEverTested, 
HBVTreatmentServices, HCVEverTested, HCVTreatmentServices, ReferralOut, 
HepABVaccinationOffer, ReferralVaccination 

 

EII # 131639: Implementation of alert message stating "System failed to generate the pdf" 
will be sent to staff and author. 

What’s changed: 

• Alert message “System failed to generate the PDF” now sent to both: 

 Admin staff (with AdminsForPDFRefresh permission). 

 Author of the document/service note. 

• Added new system configuration key: SendAlertNotificationToAuthor (default = Yes). 

 Yes: Alerts sent to Author + Admin. 

 No: Alerts only sent to Admin. 

 Invalid values default to “Yes.” 

• Alert also surfaces in New Alerts/Messages widget on the Dashboard for both recipients. 

Where to find it: 

• Path 1: Administration → Staff/Users → Roles/Permissions → Staff List → 
AdminsForPDFRefresh permission. 

• Path 2: Client → Documents. 

• Path 3: Client → Services/Notes. 

How it helps: 

• Ensures both admins and authors are notified immediately if a PDF fails to generate after signing. 

• Provides visibility in the Dashboard’s Alerts/Messages widget. 

• Configurable via new system key to control whether authors should receive notifications. 

Notes: 

• Passive change (enabled automatically). 

• Default behavior = alerts sent to both Admin and Author. 

 

 

EII # 131753: Change in ‘Consent to Share Health Information’ document 

What’s changed: 

A new enhancement has been added to the Consent to Share Health Information document to support 
granular control over shared clinical data. Users can now specify which clinical note types are included 
when selecting All Information, improving flexibility for organizations using FHIR APIs or HIE connections. 
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Key updates: 

• Introduced Clinical Note Selection pop-up for All Information option 

• Allows users to choose specific note types to include in consent 

• Enhances precision and compliance in data sharing workflows 

How it works: 

New Behavior in Document 

• Section: What information will be included 

• Radio Button: All Information 

• Clinical Note Selection Pop-up 

• Appears when All Information is selected 

• Includes checkboxes for the following note types (all preselected by default): 

• Consultation Note 

• Discharge Summary Note 

• History and Physical Note 

• Procedure Note 

• Progress Note 

• Includes Select All, Deselect All, and Apply buttons for ease of use 

Where to find it: 

Path: 
Login → Select a client → Quick Search → Consent to Share Health Information document 

Data Model Changes 

The following columns have been added to the DocumentConsentToShareHealthInformation table: 

• ConsultationNote 

• DischargeSummaryNote 

• HistoryAndPhysicalNote 

• ProcedureNote 

• ProgressNote 

• DisclosingEntity 

• RecipientOrCategory 

• DisclosurePurpose 

Dynamic Forms (DFA) 

Reference No Task No Description 

66 EII # 129990 Implementation of automatic hyperlinks in DFA list 

pages. 

EII # 129990: Implementation of automatic hyperlinks in DFA list pages. 

What’s changed: 

The Hyperlink Setup Pop-up in DFA List Pages has been enhanced with validation logic and deletion 
functionality, allowing users to manage hyperlink configurations more intuitively. 

Previously, users could only add hyperlinks via the UI, with no feedback for duplicate entries and no 
option to delete existing hyperlinks. With this release, users receive real-time validation messages and 
can remove hyperlinks through a confirmation dialog, improving control and reducing configuration errors. 

Where to find it: 
DFA List Page → View Column Configurations → Hyperlink Setup Pop-up 
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How it helps: 

• Prevents duplicate hyperlink entries with validation 

• Enables deletion of hyperlinks via confirmation dialog 

• Streamlines hyperlink setup and cleanup process 

Validation Messages: 

• Duplicate Column Parameter: 
“This Column Parameter has already been selected.” 
Triggered when attempting to add a column parameter that’s already configured 

Delete Hyperlink Workflow: 

• Delete Button: 
Located at the bottom of the Hyperlink Setup Pop-up 

Confirmation Dialog: 

• Yes: Deletes the hyperlink 

• No / Cancel: Closes the dialog without deleting 

Finalizing Setup: 

• After adding parameters, click Close in the Hyperlink Setup Pop-up 

In the List Page Configurations popup: 

1. Click Save 
2. Then click Close 

Using the Hyperlink: 

1. Navigate to the DFA List Page 
2. Click the configured hyperlink (e.g., Configuration ID) 

• Redirects user to the selected Detail Screen (e.g., ListPage Link Detail Screen) 

Notes: 

Passive change (no customer action required to enable) 

Group Services 

Reference No Task No Description 

72 EII # 130780 Group Services – Warning messages display for Overlap 

group services.   

EII # 130780: Group Services – Warning messages display for Overlap group services.   

What’s changed: 

• A new system configuration key and recode category have been introduced to handle 
overlapping services in Group Services. 

• By default, users now see a warning message when a Staff or Client has overlapping services. 

• If the configuration key is enabled, the system applies a hard stop validation for duplicate 
services in the Group Service Detail screen. 

• If the procedure code used is mapped to the new recode category, the hard stop validation is 
bypassed. 

System Configuration Key: 
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• Key: DisplayHardstopValidationForDuplicatesViaGroupServices 

• Read Key as: Display Hardstop Validation for Duplicate Services Created in Group Services 

• Allowed Values: Yes / No 

• Default Value: No 

• Modules: SCM Admin 2 

• Behavior: 

 Yes: Hard stop validation when two services share the same Client, Clinician, Program, 
Procedure, and Location. 

 No: Warning message displayed instead (default behavior). 

 Invalid values revert to default (“No”). 

Recode Category: 

• Category: ProcCodesToExcludeFromGroupServicesOverlapHardStop 

• Purpose: Procedure codes mapped here are excluded from overlap hard stop validation when 
the config key is enabled. 

Warning / Validation Messages: 

• Client overlap warning (single service): 
 “[ClientLastName], [ClientFirstName] – Overlapping service schedules were found… Clinician: 
[StaffName] on [Date/Time] for [Procedure] [Duration]. Do you want to proceed?” 

• Client overlap warning (multiple services): 
 “[ClientLastName], [ClientFirstName] – Overlapping service schedules were found… Clinician: 
[Staff1Name] … Clinician: [Staff2Name] … Do you want to proceed?” 

• Staff overlap warning: 
 “[ClientFirstName] [ClientLastName] – [StaffName] is busy during this time due to a Service. Do 
you wish to schedule this service anyway?” 

• Service/Notes overlap warning: 
 “Another service is scheduled for this client during this time. Clinician: [StaffName] on 
[Date/Time] for [Procedure] [Duration]. Do you want to save this service?” 

• Hard stop validation message: 
 “A service for this client for this date/time already exists. You cannot enter duplicate service. 
Would you like to view the Service?” 

 OK: Navigates to the existing service detail. 

 Cancel: Returns to the Group Service screen. 

How it helps: 

• Prevents accidental creation of duplicate or overlapping group services. 

• Provides flexibility via config key + recode category for org-specific needs. 

• Maintains data accuracy while still allowing controlled overlap where appropriate. 

Interfaces 

Reference No Task No Description 

80 EII # 132102 Added 'Interface Status' column in the Orders(My Office) 

and Client Orders(Client) list page 

EII # 132102: Added 'Interface Status' column in the Orders(My Office) and Client 

Orders(Client) list page 

What’s changed: 
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Added a new ‘Interface Status’ column to both the Orders (My Office) and Client Orders (Client) list 
pages. This enhancement allows users to track whether signed client orders (Lab or Medication) were 
successfully transmitted to the interface or failed. 

Previously, users had no visibility into the transmission status of client orders. Troubleshooting required 
manual investigation of interface logs. With this release, the status is now visible directly on the list pages, 
improving transparency and reducing time spent on error resolution. 

Where to find it: 

• Path 1: 
Client → Client Orders → New Order (Medication or Lab) → Save and Sign 

• Path 2: 
My Office → Orders → Orders list page → View Column Configurations → Enable ‘Interface 
Status’ 

• Path 3: 
Client → Client Orders → Client Orders list page → View Column Configurations → Enable 
‘Interface Status’ 

• Path 4: 
Administration → Messages Interface → Messages Interface list page → Message Interface 
Detail 

How it helps: 

• Displays Success or Failure status for each signed client order 

• Enables quick identification of transmission issues 

• Reduces reliance on backend log reviews 

Notes: 

• Passive change (no customer action required to enable) 

• Applies to both Lab and Medication orders 

Methadone 

Reference No Task No Description 

81 EII # 131648  MAT: Implemented ‘Scheduled For Date’ field to the 

‘Medication Inventory Transaction list’ page and 

Medication Inventory Transaction Details page. 

83 EII # 132198 MAT: Implemented new search options for the client 

search on the MAT Management list page using their 

DOB/SSN/MRN.  

EII # 131648: MAT: Implemented ‘Scheduled For Date’ field to the ‘Medication Inventory 

Transaction list’ page and Medication Inventory Transaction Details page. 

What’s changed: 

• Added new “Scheduled For Date” field to the Medication Inventory Transaction List and 
Medication Inventory Transaction Detail pages. 

• Nurses now have visibility into the scheduled dose date (distinct from dispense or adjustment 
dates). 

• In the List page, the “Date Range” filter has been renamed to “Transaction Date Range.” 

• In the Detail page, the “Location” field is moved to the top, and the new Scheduled For Date 
field is displayed as read-only. 
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How it works: 

• Scheduled For Date reflects the scheduled dose date, not the dispense, revert, or re-dispense 
date. 

 For take-homes: shows the client’s scheduled take-home date. 

 For pre-pours: shows the scheduled pre-pour dose date. 

 The value remains unchanged even after reverts, spills, or re-dispenses. 

• Field is auto-populated and non-editable. 

• Field is not displayed when creating new inventory adjustments or transfers. 

Where to find it:  

1. Administration → Orders → Orders → New → Order Details 
a. Create MAT Medication Order (with Take Home Allowed and Machine Connection = 

Yes). 
2. My Office → Medication/Lot/Bottle → New → Details 

a. Create inventory record. 
3. Client → Client Orders → New → Client Order Details 

a. Prescribe and sign MAT order. 
4. My Office → MAT Management → Connect User → Connection Details popup 

a. Connect to machine/inventory. 
5. My Office → MAT Management → Select Order → Dispense icon 

a. Dispense scheduled/future take-home dose. 
6. My Office → Medication Inventory Transaction List 

a. Verify new column Scheduled For Date. 
7. My Office → Medication Inventory Transaction List → Quantity hyperlink → Detail page 

a. Verify Scheduled For Date field. 

How it helps: 

• Improves nurse efficiency by distinguishing between scheduled dose dates and transaction 
dates. 

• Reduces confusion in MAT workflows when handling take-homes, pre-pours, reverts, or re-
dispenses. 

 

EII # 132198: MAT: Implemented new search options for the client search on the MAT 
Management list page using their DOB/SSN/MRN. 

What’s changed: 

The MAT Management list page client search field now supports additional criteria: 

• Date of Birth (DOB) (MM/DD/YYYY format) 

• Social Security Number (SSN) (last 4 digits) 

• Medical Record Number (MRN) 

These are added alongside the existing Client Name and Client ID search options. This improves usability 
and accuracy when locating client records. 

How it works: 

• DOB search: Enter MM/DD/YYYY → matches clients by DOB. 
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• SSN search: Enter 4 digits → matches clients by last 4 of SSN. 

• Client ID search: Enter fewer than 4 digits → searches Client ID. 

• MRN/External Client ID search: Enter ≤ 5 digits → searches Client ID, MRN, and External Client 
ID. 

• Alphanumeric search (≥ 5 characters): searches Client ID, MRN, and External Client ID. 

• Changing Program or Date filter automatically clears the Client Search field. 

Where to find it: 

1. Administration → Orders → Orders → New → Order Details 
 Create MAT Medication Order (set Medication Assisted Treatment = Yes, Machine Connection 
Required = Yes, Take Home Allowed = Yes). 

2. My Office → Medication/Lot/Bottle → New → Details 
 Create inventory record. 

3. Client → Client Orders → New → Client Order Details 
 Prescribe and sign MAT order. 

4. My Office → MAT Management → List page → Filter section 
a. Select MAT Program. 
b. Enter DOB, SSN, or MRN in Client Search field. 
c. Apply filter → matching client record(s) displayed in grid. 

How it helps: 

• Enables faster, more accurate searches for client records. 

• Reduces reliance on only name or ID, minimizing errors. 

• Streamlines staff workflows in MAT client management. 

Mobile 

Reference No Task No Description 

95 EII # 123604 Implementation of Searchable drop down for client field 

in Create Service and Create Documents screen in 

Mobile Web App. 

EII # 123604: Implementation of Searchable drop down for client field in Create Service 

and Create Documents screen in Mobile Web App. 

What’s changed: 

The Mobile Web App has been enhanced to include a searchable dropdown for the Client field on both 
the Create Service and Create Document screens. 

Previously, the Client dropdown was static and non-searchable, making it difficult for staff to locate 
specific clients—especially when managing large caseloads. With this release, users can now search by 
Client Name or Client ID, improving efficiency and aligning with accessibility and responsive design 
standards. 

Where to find it: 

• Path 1: 
SmartCare Web App → Login → Enter Smart Key → Home → Create Service → Client field 

• Path 2: 
SmartCare Web App → Login → Enter Smart Key → Home → Documents → Create Document 
→ Client field 

How it helps: 
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• Enables fast lookup of clients using a typeable, searchable dropdown 

• Supports search by Client Name or Client ID 

• Improves usability for staff with large caseloads 

• Enhances accessibility and mobile responsiveness 

Functionality: 

• Search begins after typing 3 or more characters 

• Results are dynamically filtered based on input 

• No performance degradation observed with large datasets 

• Consistent behavior verified across devices and browsers 

Notes: 

• Passive change (no customer action required to enable) 

• Applies to both Create Service and Create Document workflows 

My Preference 

Reference No Task No Description 

99 EII # 130666 Added checkbox NotifyForDiscontinuedMedications in 
My Preferences screen 

EII # 130666: Added checkbox NotifyForDiscontinuedMedications in My Preferences 
screen 

What’s changed: 

• Added a new checkbox: “Notify If Medications are Discontinued” in the Check In Notification 
Preferences tab under My Preferences (My Office). 

• When enabled, providers will be notified if a nurse discontinues a medication in Rx. 

Where it appears: 

• Go Search → My Preferences (My Office) → Check In Notification Preferences tab. 

How it helps:  

• Improves communication between nurses and providers by alerting providers when medications 
are discontinued. 

Other details: 

• Passive Change (no customer action required) 

• Data Model Changes: New column NotifyForDiscontinuedMedications added in 
StaffPreferences table 

My Reports/UDS Reports  

Reference No Task No Description 

100 EII # 129471 Implementation of the report ‘UDS Table 6B Section C - 
Childhood Immunization Status’ to 2025 Standard. 



SmartCare Release Notes  

39 

 

101 EII # 129476 Implementation of the ‘UDS Table 6B Details - Section H- 
Statin Therapy for the Prevention and Treatment of 
Cardiovascular Disease Report’ to 2025 Standard. 

102 EII #129477 Implementation of the ‘UDS Table 6B Details- Section I - 
Ischemic Vascular Disease (IVD): Use of Aspirin or 
Another Antiplatelet’ report to 2025 Standard. 

103 EII # 129478 Implementation of the ‘UDS Table 6B Details - Section J 
- Colorectal Cancer Screening’ Report’ to 2025 Standard. 

104 EII # 129482 Implementation of the ‘UDS Table 6B Details: Section A 
and B: Demographic Characteristic of Prenatal Care 
Patients’ to 2025 standard. 

105 EII # 129610 Implementation of a new ‘UDS Table 6B Details- Section 
N - Initiation and Engagement of Substance Use 
Disorder Treatment (CMS137v13)’ -FOR 2025 Reporting 
Year. 

106 EII # 130339 Changes are implemented to the ‘UDS Table 5 Staffing 
and Utilization’ report for the reporting year 2025. 

108 EII # 131629 New changes are implemented to the Evidence Based 
Practices – IPP T3 Indicator Report. 

109 EII # 131686 Changes are implemented to the ‘UDS Table Patients by 
ZIP Code’ report for the reporting year 2025. 

110 EII # 131688 Changes are implemented to the ‘UDS Table 3A: 
Patients by Age and by Sex’ report for reporting year 
2025. 

117 EII # 132223 Implementation of ‘Staff 3PL Update Report’. 

EII # 129471: Implementation of the report ‘UDS Table 6B Section C - Childhood 
Immunization Status’ to 2025 Standard. 

What’s changed:  

The Childhood Immunization Status report in UDS Table 6B – Section C has been updated to align 
with the 2025 CMS117v13 reporting standard. These enhancements improve accuracy, traceability, and 
usability for reporting immunizations for children under age 2. 

Key Enhancements 

• Updated measure logic and value sets per CMS117v13 

• New date filters: Start Date and End Date 

• Improved grid logic for Denominator, Numerator, and Exclusions 

• Streamlined interface: outdated fields removed, validation messages added 

• Enhanced navigation with hyperlinks to relevant screens and documentation 

How it works 

New Filters 

• Reporting CY: Defaults to the most recent calendar year 

• Start Date: Defaults to Jan 1 of selected CY; must be manually updated if CY changes 

• End Date: Defaults to Dec 31 of selected CY; must be manually updated if CY changes 
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Validation Messages 

• “Start Date must fall within the Reporting Year” 

• “Start Date cannot be later than End Date. Please select valid dates.” 

Where to find it:  

Path 1: My Office → UDS Table 6B Quality of Care Measures → Section C → Detail Report 

Path 2: My Office → UDS Table 6B Details – Section C (Quicklink) 

Grid & Summary Section Updates 

• Removed: Total Clients column (2025 reporting year) 

• Updated: 
o Denominator logic per CMS117v13 
o Numerator logic for all vaccine types 
o Expanded Exclusion logic with new diagnosis and service-based criteria 

Logic 

Denominator Criteria 

• Clients must: 
o Be enrolled in an FQHC program during the reporting year 
o Be age 2 at any point during the reporting period 
o Have a qualifying FQHC service 
o Not meet exclusion criteria 

Numerator Criteria 

• Clients must: 
o Meet denominator criteria 
o Have vaccine status = Received or Received Elsewhere 
o Receive immunizations before their 2nd birthday 
o Meet count/timing requirements per vaccine type 
o Qualify for diagnosis-based alternatives (MMR, Hep B, VZV, Hep A) 

Vaccines & Value Set OIDs 

Vaccine Requirement OID(s) 

DTaP ≥4 doses 2.16.840.1.113883.3.464.1003.196.12.1214 

IPV ≥3 doses 2.16.840.1.113883.3.464.1003.196.12.1219 

MMR ≥1 dose or 
diagnosis 

2.16.840.1.113883.3.464.1003.196.12.1224 

Hib ≥3 doses 2.16.840.1.113883.3.464.1003.110.12.1083, 1085 

Hep B ≥3 doses or 
diagnosis 

2.16.840.1.113883.3.464.1003.196.12.1216, 
2.16.840.1.113883.3.67.1.101.1.269 
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VZV ≥1 dose or 
diagnosis 

2.16.840.1.113883.3.464.1003.196.12.1170, 
2.16.840.1.113883.3.464.1003.110.12.1039 

PCV ≥4 doses 2.16.840.1.113883.3.464.1003.196.12.1221 

Hep A ≥1 dose or 
diagnosis 

2.16.840.1.113883.3.464.1003.196.12.1215, 
2.16.840.1.113883.3.464.1003.110.12.1024 

RV 3-dose or 2-dose 
schedule 

2.16.840.1.113883.3.464.1003.196.12.1223 

Flu ≥2 doses 2.16.840.1.113883.3.464.1003.196.12.1218 

Exclusion Criteria 

• Clients are excluded if: 
o Vaccine status = Contraindication 

• Diagnosis matches any of the following: 
o Severe Combined Immunodeficiency 
o Immune Disorders 
o HIV 
o Malignant Neoplasm 
o Intussusception 
o Hospice Diagnosis 
o Hospice Care flag active during reporting year 
o Encounter matches hospice codes 
o Billing code matches CMS117v13 value set 

Where to find it:  

Path 1: My Office → UDS Table 6B Quality of Care Measures → Section C → Detail Report 

Path 2: My Office → UDS Table 6B Details – Section C (Quicklink) 

Explanation of Data: Collapsed by default; expandable via + icon (e.g., EII #129476) 

EII # 129476: Implementation of the ‘UDS Table 6B Details - Section H- Statin Therapy for 
the Prevention and Treatment of Cardiovascular Disease Report’ to 2025 Standard. 

What’s changed: 

• Updated to 2025 Standard (CMS347v8) for UDS Table 6B Details – Section H: Statin Therapy 
for the Prevention and Treatment of Cardiovascular Disease (Line 17a). 

• Added Start Date and End Date filters (MM/DD/YYYY) to pull records within a selected range. 

• Content & logic refresh: measure value sets updated; “Initial Population” removed from 
Explanation of Data for 2025; grid title/labels aligned to CMS347v8. 

• Report shows client-level detail for Denominator, Numerator, Exclusions, Exceptions with 
refreshed logic tied to 2025 value sets. 

• Note: “Total Clients” column removed for the 2025 reporting year. 

Where to find it: 

• Path 1: My Office → UDS Table 6B Quality of Care Measures → Section H — Statin Therapy… 
(CMS347v8) → click Detail. 

• Path 2: My Office → UDS Table 6B Details – Section H (Quicklink). 
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o Reference: CMS347v8 details at eCQI (link in report header). 

How it helps: 

• Lets users see the full list of eligible clients and the data behind Meets Denominator/Numerator, 
Exclusions, Exceptions for Section H. 

• Date filters support precise period analysis. 

Notes: 

• Passive change (no customer action required to enable). 

• Validation messages enforce correct date use (e.g., “Start Date must fall within the Reporting 
Year” and “Start Date cannot be later than End Date”). 

• 2025 updates carry forward for 2026 until a 2026 standard is published. 

 

EII # 129477l: Implementation of the ‘UDS Table 6B Details- Section I - Ischemic Vascular 
Disease (IVD): Use of Aspirin or Another Antiplatelet’ report to 2025 Standard. 

What’s changed: 

• Updated to 2025 Standard (CMS164v7) for UDS Table 6B Details – Section I: Ischemic 
Vascular Disease (IVD): Use of Aspirin or Another Antiplatelet. 

• Added Start Date and End Date filters (MM/DD/YYYY) to pull records within a selected range. 

• Content & logic refresh: grid/labels aligned to 2025; Explanation of Data removes Initial 
Population for 2025; Total Clients removed from Summary. 

• Denominator logic: FQHC program + qualifying encounter (value sets: Office Visit, Annual 
Wellness Visit, Preventive Care, Home Healthcare) and IVD/AMI diagnosis/service conditions per 
CMS164v7. 

• Numerator logic: Active medication aspirin or other antiplatelet during measurement year 
(RXNORM mapped to CMS164v7 value set). 

• Exclusions: Anticoagulant medication overlap during the measurement period; hospice care flag; 
additional hospice-related criteria per measure guidance. 

Where to find it: 

• Path 1: My Office → UDS Table 6B Quality of Care Measures → Section I — IVD: 
Aspirin/Antiplatelet → click Detail. 

• Path 2: My Office → UDS Table 6B Details – Section I (Quicklink). 

• Reference: CMS164v7 (eCQI link is presented as a hyperlink in the report header). 

How it helps: 

• Enables users to view the full eligible client list and the data contributing to Denominator, 
Numerator, and Exclusions for Section I. 

• Date filters support precise period analysis and auditability. 

Notes: 

• Passive change (no enablement steps required by customers). 

• Validation messages enforce correct dates, e.g.: 
o “Start Date must fall within the Reporting Year.” 
o “Start Date cannot be later than End Date. Please select valid dates.” 

• 2025 updates apply to 2026 until a 2026 standard is published. 
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EII # 129478: Implementation of the ‘UDS Table 6B Details - Section J - Colorectal Cancer 
Screening’ Report’ to 2025 Standard. 

What’s changed: 

• Updated to 2025 Standard (CMS130v13) for UDS Table 6B Details – Section J: Colorectal 
Cancer Screening. 

• Added Start Date and End Date filters (MM/DD/YYYY) for record selection within a specific 
range. 

• Content & logic refresh: 
o Explanation of Data removes Initial Population for 2025. 
o Total Clients removed from Summary section. 
o Client details now shown only if they meet Denominator, Numerator, or Exclusion 

criteria. 

• Denominator logic: FQHC enrollment + qualifying encounter; clients age 46–75; services must 
map to CMS130v13 value sets (Office Visit, Annual Wellness, Preventive Care, Home 
Healthcare, Virtual Encounter, Telephone Visits). 

• Numerator logic: Qualifying colorectal cancer screening within specified lookback windows 
(Colonoscopy ≤9 years; Flexible Sigmoidoscopy ≤4 years; CT Colonography ≤4 years). Data can 
come from flowsheets or services. 

• Exclusions: Malignant neoplasm of colon, hospice/palliative care encounters, hospice/palliative 
care diagnoses, or total colectomy. 

Where to find it: 

• Path 1: My Office → UDS Table 6B Quality of Care Measures → Section J — Colorectal 
Cancer Screening → click Detail. 

• Path 2: My Office → UDS Table 6B Details – Section J (Quicklink). 

• Reference: CMS130v13 (eCQI link available in report header). 

How it helps: 

• Provides visibility into clients meeting screening requirements, along with Screen Type, Screen 
Date, Denominator/Numerator status, Exclusions, and Exclusion Reasons. 

• Supports accurate 2025 reporting and audit tracking. 

Notes: 

• Passive change (no enablement steps required by customers). 

• Validation messages enforce correct dates, e.g.: 
o “Start Date must fall within the Reporting Year.” 
o “Start Date cannot be later than End Date. Please select valid dates.” 

• 2025 updates apply to 2026 until a 2026 standard is published. 

 

EII # 129482: Implementation of the ‘UDS Table 6B Details: Section A and B: 
Demographic Characteristic of Prenatal Care Patients’ to 2025 standard. 

What’s changed: 
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• Updated to 2025 Standard for UDS Table 6B Details: Section A & B – Demographic 
Characteristics of Prenatal Care Patients. 

• Reporting CY filter now drives logic for the reporting year. 2025 updates will apply to 2026 until 
the 2026 standard is published. 

• New fields added to Filters: 
o Start Date (defaults to Jan 1 of selected CY; must be adjusted manually if CY changes). 
o End Date (defaults to Dec 31 of selected CY; must be adjusted manually if CY changes). 
o Both include validation messages to enforce correct ranges: 

▪ “Start Date must fall within the Reporting Year.” 
▪ “Start Date cannot be later than End Date. Please select valid dates.” 

• New Grid Column: 
o Date of Birth now displays client DOB from demographics. 

• System behavior: Filters exclude clients tied to certain procedure categories 
(UDSScreeningProcedures, UDSGroupVisitsProcedures, UDSDispenseMedsProcedures, 
UDSHealthCheckProcedure, UDSWICServicesProcedure). 

Where to find it: 

• My Office → UDS Table 6B Details: Section A and B → Demographic Characteristics of 
Prenatal Care Patients report. 

How it helps: 

• Ensures demographic reporting aligns with 2025 UDS standards. 

• Adds DOB visibility for prenatal care clients. 

• Improves reporting accuracy with CY-driven logic and date-range validation. 

Notes: 

• Passive change (no enablement steps required by customers). 

 

EII # 129610: Implementation of a new ‘UDS Table 6B Details- Section N - Initiation and 
Engagement of Substance Use Disorder Treatment (CMS137v13)’ -FOR 2025 Reporting 
Year. 

What’s changed: 

A new report titled UDS Table 6B Details – Section N – Initiation and Engagement of Substance Use 
Disorder Treatment (CMS137v13) has been implemented for the 2025 Reporting Year. 

This enhancement provides detailed visibility into client-level data for Section N, supporting CMS137v13 
measure logic. Users can now view eligible clients, numerator/denominator/exclusion counts, and the 
data used to calculate these metrics—improving transparency, compliance, and reporting efficiency. 

Where to find it: 

My Office → UDS Table 6B Details – Section N – Initiation and Engagement of Substance Use Disorder 
Treatment 

How it helps: 

• Displays client-level detail for: 
o Denominator 
o Numerator (Line 23a & 23b) 
o Exclusions 
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o Exclusion Reasons 
o Supports CMS137v13 logic for substance use disorder treatment initiation and 

engagement 
o Enables filtering by reporting year, date range, grant type, and FQHC program 

Filter Setup: 

• Reporting CY: Defaults to latest year; manual update required if CY changes 

• Start/End Date: Mandatory; validation messages enforce correct date range 

• Grant Type by Plan: Universal (default), MHC, HCH, PHPC 

• Grant Type by Client Info: Filters based on client categories (e.g., Migratory, HomelessShelter) 

• FQHC Program: Defaults to “All FQHC Programs” 

Titles Displayed (2025 Reporting Year): 

• Title 1: UDS Table 6B Details – Section N 

• Title 2: CMS137v13 

• Title 3: CMS137v13 Link 

Explanation of Data: 

• Collapsed by default; expandable 

• “Initial Population” removed for 2025 

Summary Section: 

Removed: “Total Clients” field 

Displayed Columns: 

• Total Denominator Population (Line 23a & 23b) 

• Total Numerator Population (Line 23a & Line 23b) 

• % Numerator (Line 23a & Line 23b) 

• Total Excluded (Line 23a & Line 23b) 

Grid Section Logic: 

Only clients matching Denominator, Numerator, or Exclusion criteria are shown 

Displayed Columns: 

• ClientID, Name, DOB, Age 

• Qualifying Encounter Date 

• Substance Use Disorder Diagnosis 

Numerator Logic: 

• Line 23a: 
Client qualifies if treatment occurs within 14 days of qualifying encounter via: 

o Service (e.g., psychotherapy, virtual visits) 
o Medication order (short-acting or long-acting) 
o Medication administration 

• SUD Treatment Type (Line 23a): 
Displays source of qualification: 

o “Order – [Order Name]” 
o “Service – [Service Code]” 

• SUD Treatment Date (Line 23a): 
Displays first qualifying treatment date 

• Line 23b: 
Client qualifies if follow-up treatment occurs within 34 days of initiation via: 

o One or two services 
o One or two medication orders 
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o Combination of service and order 

• SUD Treatment Type (Line 23b): 
Displays source(s) of qualification 

• SUD Treatment Date (Line 23b): 
Displays all qualifying dates (comma-separated) 

Exclusion Logic: 

Client is excluded if: 

• Hospice Care flag is active 

• Service matches CMS130v13 value sets 

• Diagnosis matches Hospice Diagnosis value set 

• Exclusion Reason: 
Displays first applicable reason: 

o Diagnosis-based 
o Hospice Care flag 
o Service-based 

If no reason found, field remains blank 

Notes: 

• Passive change (no customer action required to enable) 

• Hyperlink to CMS137v13 opens in a new tab 

• Validation messages guide correct date and filter selections 

 

EII # 130339: Changes are implemented to the ‘UDS Table 5 Staffing and Utilization’ 
report for the reporting year 2025. 

What’s changed: 

The UDS Table 5 – Staffing and Utilization report has been updated to reflect the 2025 reporting 
standard, including enhancements to filters, grid logic, personnel categorization, and UI labels. 

A new Selected Service Detail Addendum section has been introduced to support detailed reporting for 
Mental Health and Substance Use Disorder services. Services in Completed status are now exclusively 
considered, and several personnel categories and row labels have been added or updated. 

Where to find it: 

• Path 1: 
My Office → UDS Table 5 Staffing and Utilization 

• Path 2: 
My Office → UDS Table 5 Staffing and Utilization → Table 5 Detail Report hyperlink 

How it helps: 

• Aligns reporting logic with 2025 CMS standards 

• Improves accuracy by filtering out non-completed services 

• Adds support for Mental Health and SUD service tracking 

• Expands personnel categorization for more granular reporting 

Filter Setup: 

• Reporting CY: Updated to 2025 

• Start Date: Defaults to Jan 1 of selected CY; must be manually updated if CY changes 

• End Date: Defaults to Dec 31 of selected CY; must be manually updated if CY changes 

Validation Messages: 
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• Start/End Dates must fall within the selected Reporting CY 

• Title Display Example: 
January 1, 2025 through December 31, 2025 

Verified Functionality: 

• Grid Section Updates: 
o Clinic Visits (b): 
o Counts face-to-face services with Completed status 
o Mode of Delivery = Face to Face 
o Place of Service ≠ 02 (Telehealth) or 10 (In-home Tele) 
o Procedure mapping uses Major Service Category hierarchy 

• Virtual Visits (b2): 
o Counts telephone/video services with Completed status 
o Mode of Delivery = Telephone or Video Conference 
o Place of Service = 02 or 10 
o Procedure mapping follows same hierarchy as Clinic Visits 

• Patients (c): 
o Displays count of clients with at least one reportable service in Completed status during 

the reporting year 

• Removed Columns: 
o Show and Cancelled/No Show removed from: 

▪ Clinic Visits (b) 
▪ Virtual Visits (b2) 

• New Section: Table 5 – Selected Service Detail Addendum 
o Title: Table 5: Selected Service Detail Addendum 
o Columns: 

▪ Line 
▪ Personnel by Major Service Category 
▪ Clinic Visits (b) – with MH or SUD diagnosis 
▪ Virtual Visits (b2) – with MH or SUD diagnosis 
▪ Patients (c) 

o Diagnosis Filtering: 
▪ Services must include a Mental Health or Substance Use Disorder diagnosis 

(Refer to MH and SUD Diagnoses tab) 
o Procedure Mapping Logic: 

▪ Uses Major Service Category from Procedure Code Details 
▪ Applies hierarchy if multiple categories exist 
▪ Staff’s Major Service Category takes priority if only one is selected 

o Hierarchy Includes: 
▪ Family Physicians, General Practitioners, Internists, OB/GYNs, Pediatricians 
▪ Other Specialty Physicians, Nurse Practitioners, Physician Assistants, CNMs 
▪ Ophthalmologists, Optometrists 

o Updated and New Row Labels (2025): 
▪ Updated Rows: 

• 22: Other Professional Services 

• 22c: Other Vision Care Personnel 

• 23a: Pharmacists 

• 25: Health Education Specialists 

• 27: Transportation Personnel 

• 27b: Interpretation Personnel 
▪ New Rows Added: 

• 20a01–20a04: Physicians, NPs, PAs, CNMs 

• 21a–21h: Expanded Mental Health personnel categories 
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• 23b–23d: Clinical Pharmacists, Pharmacy Technicians, Other Pharmacy 
Personnel 

• 23: Pharmacy Personnel (Sum Lines 23a–23d) 

• 29a: Other Programs and Services 

• 29b: Quality Improvement Personnel 

• 30a–30c: Management, Fiscal/Billing, IT Personnel 

• 31–33: Facility, Patient Support, and Total Non-Clinical Support 
Personnel 

Notes: 

• Passive change (no customer action required to enable) 

• Applies to 2025 reporting year; carries forward until a 2026 standard is published 

 

EII # 131629: New changes are implemented to the Evidence Based Practices – IPP T3 
Indicator Report. 

What’s changed: 

• Added a new Evidence-Based Practices – Client Service sub-report to the IPP T3 Indicator 
Report. 

• Added Clinician, Program, and Location fields to the Service Details sub-report. 

• Client Service sub-report now displays: 

 Client Name and ID 

 Service Program, Service Name, Service Date 

 EBP values from TRACKEBPUTILIZED (multiple selections display in separate rows) 

 Active Coverage Plans (Coverage Plan 1 … N in sequence) 

Where to find it: 

• Path 1: My Office → Evidence Based Practices – IPP T3 Indicator Report → Total Clients 
Evaluated for Reporting Period (hyperlink) → Client ID (hyperlink) → Client Details → Client 
Service 

• Path 2: My Office → Evidence Based Practices – IPP T3 Indicator Report → Client Details → 
EBP Services (hyperlink) 

How it helps: 

• Provides a dedicated sub-report to view client-level service details tied to EBPs. 

• Displays coverage plan information in sequence when clients have multiple active plans. 

• Adds transparency by including clinician, program, and location fields in Service Details. 

Notes: 

• Passive change (no customer action required). 

Prerequisite: A signed Individual Service Note must exist. 

EII # 131686: Changes are implemented to the ‘UDS Table Patients by ZIP Code’ report 
for the reporting year 2025. 

What’s changed: 
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• Updated UDS Table Patients by ZIP Code report to 2025 Standard (Jan 1 – Dec 31, 2025). 

• Now only includes patients who: 
o Have a service in Completed status with an FQHC-associated Program, or 
o Have an FQHC coverage plan during the reporting year. 

• Added Start Date and End Date filters (MM/DD/YYYY). 
o Both are mandatory; defaults to Jan 1 and Dec 31 of the selected Reporting CY. 
o Users must manually adjust if Reporting CY changes. 
o Validation messages ensure dates fall within the selected year. 

• Minor UI/logic refresh for both Summary and Patient Detail reports. 

Where to find it: 
 My Office → UDS Table Patients by ZIP Code → Report → View Patient Detail Report (hyperlink). 

How it helps: 

• Aligns ZIP Code reporting with 2025 standards. 

• Ensures only patients displayed in the Patient Detail Report are counted in the ZIP Code report. 

• Start/End date filters give precise reporting control. 

Notes: 

• Passive change (no setup required). 

• 2025 updates will carry forward until 2026 standard is published. 

 

EII # 131688: Changes are implemented to the ‘UDS Table 3A: Patients by Age and by 
Sex’ report for reporting year 2025. 

What’s changed: 

• Updated UDS Table 3A: Patients by Age and by Sex report to 2025 Standard (Jan 1 – Dec 31, 
2025). 

• Now only includes patients who: 
o Have a service in Completed status with an FQHC-associated Program, or 
o Have an FQHC coverage plan during the reporting year. 

• Added Start Date and End Date filters (MM/DD/YYYY). 
o Defaults to Jan 1 and Dec 31 of the selected Reporting CY. 
o Mandatory fields; must be manually adjusted if CY changes. 
o Validation messages enforce correct year/date range. 

• Report title updated from “UDS Table 3A: Patients by Age and by Sex Assigned at Birth” → 
“UDS Table 3A: Patients by Age and by Sex”. 

Where to find it: 
 My Office → UDS Table 3A: Patients by Age and by Sex → Report → View Patient Detail Report 
(hyperlink). 

How it helps: 

• Aligns Age/Sex reporting with UDS 2025 standards. 

• Ensures accuracy by displaying only eligible clients in both the main and Patient Detail reports. 

• Provides more precise reporting with Start/End date filters. 

Notes: 
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• Passive change (no setup required). 

• 2025 updates carry forward until 2026 standard is published. 

 

EII # 132223: Implementation of ‘Staff 3PL Update Report’. 

What’s new: 

• Introduced Staff 3PL Update Report to allow bulk updates to staff records. 

• Supports adding/removing Programs, Procedures, Proxy settings, and Locations across multiple 
staff at once. 

• Two sub-reports included: 

 3PL Add/Remove Report – add or remove Programs, Procedures, Proxies, or Locations 
for selected staff. 

 3PL Copy Report – copy one staff member’s Programs, Procedures, Proxies, and 
Locations to another. Options include: 

 Exact Copy (overwrite to match source) 

 Add Only (include missing items without removing existing). 

• Preview mode available: choose Only Show Results of What Would Happen to see changes 
before applying them. 

• Apply mode available: choose Modify the Staff Records in SmartCare to commit updates. 

Where to find it: 

• My Office → Staff 3PL Update Report → select sub-report → choose Action (Preview or Modify) 
→ View Report. 

How it helps: 

• Eliminates manual, one-by-one updates to staff Programs, Procedures, Proxies, and Locations. 

• Streamlines admin workflows by enabling efficient, bulk modifications. 

• Provides a safe preview option before applying changes. 

Notes: 

• Passive change (feature available to all; no action required to enable). 

Reception 

Reference No Task No Description 

124 EII # 131965 To display the flag icons or the total count of flags in the 

All Flags and Reception Flags columns using the 

configuration key settings in the Reception/Front Desk 

screen. 

EII # 131965: To display the flag icons or the total count of flags in the All Flags and 

Reception Flags columns using the configuration key settings in the Reception/Front 

Desk screen. 

What’s changed: 

• Two new configuration keys introduced: 
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 DisplayIconsForReceptionFlagsInReception 

 DisplayIconsForAllFlagsInReception 

• These keys control whether the Reception Flags and All Flags columns in the Reception/Front 
Desk screen show individual flag icons or just the total count. 

• If set to Yes: 

 First 6 flag icons display directly. 

 Additional flags show as a numeric count hyperlink. 

 Clicking the hyperlink opens a pop-up with remaining flag icons. 

 Clicking an individual flag navigates to Client Flag Details. 

• If set to No: 

 Default behavior remains (only total count shown as a hyperlink with hover pop-up). 

Where to find it: 

• Path 1: Administration → Configuration Keys → open 
DisplayIconsForReceptionFlagsInReception → set to Yes → Save. 

• Path 2: Administration → Configuration Keys → open DisplayIconsForAllFlagsInReception → set 
to Yes → Save. 

• Path 3: My Office → Reception/Front Desk → verify Reception Flags and All Flags columns. 

How it helps: 

• Provides clearer, at-a-glance visibility of client flags. 

• Supports quick navigation directly from flag icons to Client Flag Details. 

• Reduces reliance on hover-only behavior. 

Notes: 

• Passive change (no customer action unless configuration keys are updated). 

• Default values for both keys = No (retains existing behavior). 

• Invalid values default back to No (total count only). 

RWQM 

Reference No Task No Description 

126 EII # 131989 RWQM Updates: Implementing DOS From and DOS To 

filer: Front End 

127 EII # 132017 RWQM Updates: Implementing DOS From and DOS To 

filer: Back End 

EII # 131989: RWQM Updates: Implementing DOS From and DOS To filer: Front End 

What’s changed: 

A new enhancement has been added to the RWQM Rule Details screen to improve the accuracy of 
services included in the RWQM Work Queue by introducing Date of Service (DOS) filters. 

Key updates: 

• Added DOS From and DOS To fields to RWQM rule configuration 

• Enables precise control over which services are evaluated by the rule 

• Improves relevance and accuracy of Work Queue results 

How it works: 
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New Fields in Rule Configuration 

Location: 
RWQM Rule Details → General tab → Rule Configuration section 

• Field: DOS From 

 Type: Date 

 Purpose: Defines the start date for eligible services 

 Default: If left blank, defaults to 01/01/1900 

• Field: DOS To 

 Type: Date 

 Purpose: Defines the end date for eligible services 

 Default: If left blank, defaults to current date 

Impact on Work Queue 

• Rule-Level Filters: 
DOS From and DOS To determine which charges are included in the Work Queue 

• List Page Filters: 
DOS filters on the Work Queue list page allow users to view and target specific charges already 
included 

• Note: 
These filters serve distinct purposes but work together to improve control and visibility 

Where to find it: 

Create RWQM Rule 
Administration → RWQM Rules → Click New → Enter required details → Click Save 

View Work Queue Results 
My Office → RWQM Work Queue → Use DOS filters on the list page → Apply Filter → View results 

Data Model Changes 

Two new columns added to the RWQMRules table: 

• DateOfServiceFrom 

• DateOfServiceTo 

 

EII # 132017: RWQM Updates: Implementing DOS From and DOS To filer: Back End 

What’s changed: 

The RWQM Rules configuration has been enhanced to support Date of Service (DOS) From and To 
filters, allowing rules to optionally specify a date range for charge evaluation. 

Previously, RWQM Rules did not consider DOS filters, which resulted in services outside the intended 
date range being included in the RWQM Work Queue. With this release, the system now evaluates 
charges based on the specified Start DOS (From) and End DOS (To) fields, improving accuracy and 
relevance. 

Where to find it: 

• Path 1: 
Administration → RWQM Rules → New → Enter details → Save 

• Path 2: 
My Office → RWQM Work Queue → RWQM Work Queue list page 

How it helps: 
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• Filters charges based on Date of Service range 

• Ensures only relevant services are included in the RWQM Work Queue 

• Reduces manual review and improves rule precision 

New Logic Implemented: 

• Both DOS From and DOS To entered: 
Includes charges with DOS on or after the From date and on or before the To date 

• Only DOS From entered: 
Includes charges with DOS on or after the From date 

• Only DOS To entered: 
Includes charges with DOS on or before the To date 
(If left blank, system assumes current date as upper limit) 

• Neither field entered: 
All charges are considered; no date filtering applied 

Functionality: 

• DOS filters correctly applied during rule evaluation 

• Charges outside the specified date range are excluded 

• Nightly billing job (exec ssp_SCCreateRWQMWorkQueueItems) respects new DOS filters 

• RWQM Work Queue list page supports targeting specific DOS ranges 

Notes: 

• Passive change (no customer action required to enable) 

• Existing RWQM Rule logic remains unaffected 

Rx Application 

Reference No Task No Description 

128 EII # 130484 Changes are implemented to display the Client Order 
diagnosis codes under ‘Dx/Purpose’ dropdown in the 
‘Complete Medication Order’ page. 

129 EII # 130733 Implementation of conditional formatting within the 
SmartCare RX module to identify medications associated 
with inactive National Drug Codes (NDCs) 

130 EII # 131855 Implementation to display Patient Refill Requests tab on 
the Start Page of the RX application 

EII # 130484: Changes are implemented to display the Client Order diagnosis codes under 
‘Dx/Purpose’ dropdown in the ‘Complete Medication Order’ page. 

What’s changed: 

• The Dx/Purpose dropdown on the Complete Medication Order page now displays: 

 Diagnosis codes from the associated Client Order (Dx1, Dx2, Dx3 – shown first, in 
order; Dx1 selected by default). 

 Active diagnoses from the most recently signed Diagnosis document. 

 MEDICATIONPURPOSE global codes (listed last). 

• When multiple Client Orders are selected and completed together, the Dx/Purpose dropdown 
will be blank by default. 

• Client Order diagnosis codes do not display on: Patient Summary, New Order, Re-Order, 
Change Order, Add Medication, or Adjust Dosage/Schedule pages. 

Where to find it: 
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• Client → Medication Management (Rx) → Patient Summary → Medication List → Select Client 
Order → Complete Order → Complete Medication Order page → Dx/Purpose dropdown. 

How it helps: 

• Provides direct access to Client Order diagnoses during order completion. 

• Reduces manual selection by auto-defaulting the first diagnosis code. 

• Ensures dropdown reflects all relevant diagnosis sources in a clear order. 

Notes: 

• Passive change. 

• Pre-requisite: A signed Client Order with Dx1, Dx2, Dx3 selected. 

 

EII # 130733: Implementation of conditional formatting within the SmartCare RX module 
to identify medications associated with inactive National Drug Codes (NDCs) 

What’s changed: 

The SmartCare RX module now consistently applies conditional formatting for inactive NDCs across the 
Approving with Change Order and Refill Request workflows. This enhancement ensures prescribers are 
visually alerted when interacting with medications that are temporarily orderable but inactive, improving 
safety and clarity during prescribing. 

Where to find it: 

• Path 1: Approving with Change Order 
SmartCare RX → Approve Change Order → Select Drug pop-up → Strength field → Inserted 
medication display 

• Path 2: Refill Request Approval 
SmartCare RX → Reorder Medication Order screen → Select Drug pop-up → Strength field → 
Inserted medication display 

How it helps: 

• Visually flags inactive medications using bold, italicized, red text 

• Applies formatting to: 
o Medication name in Select Drug pop-up 
o Strength field after selection 
o Final inserted medication display 
o Ensures prescribers can easily differentiate between active and inactive medications 

Notes: 

• Validation logic applies when configuration key ShowInactiveNDCsForXNumberOfDays is set to 0 
or an invalid value: 

• System reverts to default behavior and blocks prescribing 

Example validation messages: 

• “Selected Strength ‘Take 1 Capsule (10mg) By Mouth Evening’ is not available for the drug 
‘Altace’. Please verify the order.” 

• “Selected Strength ‘Take 1 Capsule (10mg) By Mouth Evening’ is not available for the drug 
‘Altace 10 mg Capsule’. Please verify the order.” 

• Formatting is applied consistently across workflows 
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EII # 131855: Implementation to display Patient Refill Requests tab on the Start Page of 
the RX application 

What’s changed: 

• Added a new Patient Refill Requests tab on the Start Page of the Rx application. 

• Tab displays medication refill requests submitted by patients through the Intelichart/Patient 
Portal. 

• Users now see two distinct tabs: 

 Pharmacy Refill Requests (renamed from “Refill Requests”). 

 Patient Refill Requests (new). 

• Patient Refill Requests tab includes: 

 Prescriber dropdown (shows staff/user if medications were prescribed by them). 

 Columns for Action, Patient, Medication Requested, Requested Pharmacy. 

 Sorting by column headers. 

 Action icons: Approve, Approve with Changes, Decline. 

Where to find it: 
Client → Medication Management (Rx) → Start Page → Patient Refill Requests tab. 

How it helps: 

• Separates provider-initiated vs. patient-initiated refill requests. 

• Gives prescribers a clear view of requests coming directly from the Patient Portal. 

• Streamlines approvals, modifications, or denials in one place. 

Notes: 

• Active change (requires adoption for Rx workflows). 

• Tab name “Refill Requests” has been updated to Pharmacy Refill Requests. 

• Data model changes: new tables SmartPortalRefillRequests and SmartPortalRefillDenials. 

Scanning 

Reference No Task No Description 

138 EII # 131703 Changes are implemented to display the Core Header and 

Footer in the Scanned and Uploaded documents. 

EII # 131703: Changes are implemented to display the Core Header and Footer in the 

Scanned and Uploaded documents. 

What’s changed: 

• Core Header and Footer are now displayed on all Scanned and Uploaded documents. 

• Header content is controlled by configuration keys: 

 SetFormatToShowClientNameOnAllPagesOfPdf (Client Name format) 

 ShowClientDOBOnAllPagesOfPdf (DOB visibility) 

 SetDateValueToShowMedicaidOnAllPagesOfPDF (Medicaid ID logic) 

 ShowEffectiveDateOnAllPagesOfPDF (Effective Date visibility) 

• Footer includes Page Number and Printed On timestamp. 
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How it works: 

• Client Name: 

 None → No client name shown (default). 

 LastNameFirstName → Displays as “LastName, FirstName.” 

 FirstNameLastName → Displays as “FirstName LastName.” 

 FirstNameMiddleInitialLastName → Displays as “FirstName M. LastName.” 

• DOB: 

 Yes → Displayed in MM/DD/YYYY format on all PDF pages. 

 No → Not displayed. 

• Medicaid ID: 

 None → Not displayed (default). 

 CurrentDate → Displays Medicaid ID from active coverage plan on current date. 

 EffectiveDate → Displays Medicaid ID from active coverage plan on document Effective 
Date. 

 Anytime → Displays Medicaid ID from lowest COB coverage plan at any time. 

 If no Medicaid ID exists → Displayed as “Medicaid: NA.” 

• Effective Date: 

 No → Not displayed (default). 

 Yes → Displayed in header of all document pages. 

• Footer: Always shows Page Number and Printed On timestamp. 

Navigation: 

1. Administration → Configuration Keys 
a. Update values for the four keys listed above. 

2. My Office / Client → Scanning → Scanned Medical Records 
a. Scan or upload new images (single or batch). 

3. My Office → My Documents / Client → Documents 
a. View scanned or uploaded records → Core Header and Footer displayed. 

How it helps: 

• Ensures consistency and traceability across scanned and uploaded documents. 

• Improves visibility of client identifiers (Name, DOB, Medicaid, Effective Date). 

• Adds clarity with page numbers and timestamps in document footers. 

Services 

Reference No Task No Description 

141 EII # 129487 A  new configuration key has been introduced to evaluate 

service completion lag days based on both the Created 

Date and Completion Date. 

EII # 129487: A  new configuration key has been introduced to evaluate service 

completion lag days based on both the Created Date and Completion Date. 

What’s new: 

• Added a new configuration key: SERVICECREATIONLAGDAYS (Service Creation Lag Days). 

• This key extends lag-day evaluation logic to consider both Service Created Date and 
Completion Date. 
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• Provides more precise control over when services are included in the nightly Service Completion 
Job. 

• Works in conjunction with the existing SERVICECOMPLETIONLAGDAYS key. 

Where to find it: 

• Path 1: Administration → Configuration Keys → Search for SERVICECREATIONLAGDAYS → 
Apply Filter. 

• Path 2: Client → Services → New → Enter details → Complete Service → Charge hyperlink → 
Ledger Entries → Run nightly billing job. 

• Path 3: Client → Services → New → Enter details → Create with “Show” status → Run nightly 
billing job. 

How it helps: 

• Ensures service completion aligns with both the date a service was created and the configured 
lag period. 

• Supports consistent billing workflows by standardizing the Service Completion Job logic. 

• Reduces premature or delayed service completions by enforcing dual-date validation. 

Key details: 

• System Key: SERVICECREATIONLAGDAYS 

• Read As: Service Creation Lag Days 

• Allowed Values: Integer 

• Default Value: 0 

• Module: SCM Accounts Receivable 

• Description: Number of days after a service is created before it can be considered by the 
Service Completion Job. If the Service Creation Date is earlier than the Date of Service, the 
Service Completion Lag Days setting takes priority. 

Logic examples: 

• 0 + 0: Job runs same day → Service completes. 

• 2 (Creation) + 3 (Completion): Job after 2 days → Not complete; Job after 3 days → Completes. 

• Negative values: Treated as 0 (default behavior). 

• 5 (Creation) + 2 (Completion): Job after 2 days → Not complete; Job after 5 days → Completes. 

Notes: 

• Passive change. This enhancement provides additional logic for evaluating services performed 
prior to the current date, ensuring that the service completion job adheres to a standardized LAG 
protocol. 

• Service Creation Lag Days must be ≤ Service Completion Lag Days. 

• Invalid values default to 0 (same-day completion). 

Services/Notes 

Reference No Task No Description 

149 EII # 131811 To display Sensitive Information section based on the 

value set in DisplaySUDCheckboxToTagDataAsSUD 
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configuration key and Note tab visibility for  service note 

(SUD related) 

EII # 131811: To display Sensitive Information section based on the value set in 

DisplaySUDCheckboxToTagDataAsSUD configuration key and Note tab visibility for  

service note (SUD related) 

What’s changed: 

• Updated logic for displaying the Sensitive Information section in Services/Notes. 

• Visibility now depends on both: 

 The DisplaySUDCheckboxToTagDataAsSUD configuration key. 

 Whether the Note tab is visible for the selected Service Note. 

• Behavior: 

 If key = Yes and Note tab = Visible → Sensitive Information section is hidden. 

 If key = Yes and Note tab = Not Visible → Sensitive Information section is shown. 

 If key = No (regardless of Note tab visibility) → Sensitive Information section is hidden. 

Where to find it: 

• Path 1: Client → Services/Notes → New → Enter values → Save. 

• Path 2: Client → Services/Notes → New → Select procedure code without associated note → 
Enter other values → Save. 

How it helps: 

• Aligns Sensitive Information display with configuration and note visibility. 

• Reduces confusion and ensures correct tagging of SUD-related data. 

Notes: 

• No impact on Services or Group Services detail screens. 

• Passive change (no action required unless configuration settings need review). 

 

 

 

 

  



SmartCare Release Notes  

59 

 

Global Codes 
Global Codes are the individual entries or options assigned to a Global Code Category. Global Codes can 
be core or custom. For example, a Global Code Category and the associated Global Codes are the 
options you will select from a dropdown list.  

Review and configure the following Global Code Categories and Global Codes that belong to each 
category before performing the workflows documented in these release notes.  

Ref No. Category Name 

108 'TRACKEBPUTILIZED' 

128 MEDICATIONPURPOSE 

Recodes 
A Recode is a subset of other system codes that populate a list for a specific reporting purpose. Recodes 
create an allowed list of entries from multiple larger lists.  

Review and configure the following before performing the workflows documented in these release notes.  

Ref No. Category Code 

72 ProcCodesToExcludeFromGroupServicesOverlapHardStop 
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Ref No. Category Code 

100 UDSScreeningProcedures 

100 UDSGroupVisitsProcedures 

100 UDSDispenseMedsProcedures 

100 UDSHealthCheckProcedure 

100 UDSWICServicesProcedure 

100 FQHCHospiceCare 

101 UDSScreeningProcedures 

101 UDSGroupVisitsProcedures 

101 UDSDispenseMedsProcedures 

101 UDSHealthCheckProcedure 

101 UDSWICServicesProcedure 

102 FQHCHospiceCare 

103 UDSScreeningProcedures 

103 UDSGroupVisitsProcedures 

103 UDSDispenseMedsProcedures 

103 UDSHealthCheckProcedure 

103 UDSWICServicesProcedure 

104 UDSScreeningProcedures 

104 UDSGroupVisitsProcedures 

104 UDSDispenseMedsProcedures 

104 UDSHealthCheckProcedure 

104 UDSWICServicesProcedure 

105 UDSScreeningProcedures 

105 UDSGroupVisitsProcedures 

105 UDSDispenseMedsProcedures 

105 UDSHealthCheckProcedure 

105 UDSWICServicesProcedure 

bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129471
bookmark://_EII_/#_129478
bookmark://_EII_/#_129478
bookmark://_EII_/#_129478
bookmark://_EII_/#_129478
bookmark://_EII_/#_129482
bookmark://_EII_/#_129482
bookmark://_EII_/#_129482
bookmark://_EII_/#_129482
bookmark://_EII_/#_129610
bookmark://_EII_/#_129610
bookmark://_EII_/#_129610
bookmark://_EII_/#_129610


SmartCare Release Notes  

61 

 

Ref No. Category Code 

105 FQHCHospiceCare 

Configuration Keys 
Configuration keys are settings that instruct the system (or a particular module or page) to behave in a 
desired way. Each Key has a set of values that correspond to particular behaviors. The organization 
should determine Configuration Key settings and adjust them as needed.  

Review and configure the following before performing the workflows documented in these release notes.  

Ref No. Key Name 

15 
837PClaimCodeDescription 

33 FLOWSHEETDEFAULTTEMPLATE 

bookmark://_EII_/#_129610
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Ref No. Key Name 

45 ASSESSMENTDOCUMENTCODEID 

45 SetDurationForCoreCarePlanEndDate 

45 SetNumberValueToCalculateEndDateForAddendumCarePlan 

45 RefreshCarePlanMasterData 

45 SetReviewInCarePlan 

45 SHOWORGANIZATIONNAMEONCAREPLANRDL 

45 ShowAdditionalTimeAndDurationInCarePlanIntervention 

45 SetInterventionTabAndSectionNameForISPAndISPMCOEvents 

45 UseBTATemplateForGoalsAndObjectivesInCarePlan 

45 ShowMHAssessmentRefreshButtonOnTreatmentPlan 

45 CarePlanUseCustomGoalInitialization 

45 HideSelectedFieldsInGoalsAndTreatmentProgramTabsOfTreatmentPlan 

45 SetDurationForISPInitialization 

45 EnableReviewDateForAddendumInISP 

45 SetInitializationOfCarePlanVarybyProgram 

45 INTIALIZETREATMENTEAMCP 

45 ShowValidationForHowManySessionsInCarePlanInterventions 

45 AssessmentToInitalizeFromPreviousEpisode 

45 SetNumberofMonthsToInitializeHistoryofPresentingProblem 

45 CreateAuthWhenAddingInterventions 

45 ISPMCORequireProvider 

48 AssessmentToInitializeFromPreviousEpisode 

58 SendAlertNotificationToAuthor 

72 DisplayHardstopValidationForDuplicatesViaGroupServices 

124 DisplayIconsForReceptionFlagsInReception 

124 DisplayIconsForAllFlagsInReception 

124 DisplayIconsOnReceptionFlagsColumnInReception 
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Ref No. Key Name 

129 ShowInactiveNDCsForXNumberOfDays 

138 SetFormatToShowClientNameOnAllPagesOfPdf 

138 ShowClientDOBOnAllPagesOfPdf 

138 SetDateValueToShowMedicaidOnAllPagesOfPDF 

138 ShowEffectiveDateOnAllPagesOfPDF 

141 SERVICECREATIONLAGDAYS 

141 SERVICECOMPLETIONLAGDAYS 

149 DisplaySUDCheckboxToTagDataAsSUD 
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Data Model Changes  

Ref No. Data Model Change 

33 A New Column 'DoseAcknowledgeBy' added to the ClientOrders table 

33 
A New Column 'ShowDoseCalculator' added to the OrderStrengths table 

34 
A new column ‘NotifyPrescriberOnDiscontinuedOrder’ is added to the ‘ClientOrders’ table. 

46 Added new table ContactReferralOrganizationDomainNeeds 

46 Added new table ContactReferralOrganizationContacts 

55 A new column ‘DoNotRenderPDFImmediately’ is added to the ‘DocumentCodes’ table 

57 Added a new table ‘DocumentNOMSDemographics’ 

59 A new column ‘ConsultationNote’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

59 A new column ‘DischargeSummaryNote’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

59 A new column ‘HistoryAndPhysicalNote’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

59 A new column ‘ProcedureNote’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

59 A new column ‘ProgressNote’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

59 A new column ‘DisclosingEntity’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

59 A new column ‘RecipientOrCategory’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

59 A new column ‘DisclosurePurpose’ is added to 
the ‘DocumentConsentToShareHealthInformation’ table 

99 A New column 'NotifyForDiscontinuedMedications' is added to the 'StaffPreferences' table 

107 A New column 'Sex' is added to the 'NOMSSPARSCandidateDataSet' table 
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Ref No. Data Model Change 

107 A New column 'HIVPrevention' is added to the 'NOMSSPARSCandidateDataSet' table 

107 A New column 'HIVEverTested' is added to the 'NOMSSPARSCandidateDataSet' table 

107 A New column 'HIVTestServicesWithin30' is added to the 'NOMSSPARSCandidateDataSet' 
table 

107 A New column 'HBVEverTested' is added to the 'NOMSSPARSCandidateDataSet' table 

107 A New column 'HBVTreatmentServices' is added to the 'NOMSSPARSCandidateDataSet' 
table 

107 A New column 'HCVEverTested' is added to the 'NOMSSPARSCandidateDataSet' table 

107 A New column 'HCVTreatmentServices' is added to the 'NOMSSPARSCandidateDataSet' 
table 

107 A New column 'ReferralOut' is added to the 'NOMSSPARSCandidateDataSet' table 

107 A New column 'HepABVaccinationOffer' is added to the 'NOMSSPARSCandidateDataSet' 
table 

107 A New column 'ReferralVaccination' is added to the 'NOMSSPARSCandidateDataSet' table 

126 A New column 'DateOfServiceFrom' is added to the 'RWQMRules' table 

126 A New column 'DateOfServiceTo' is added to the 'RWQMRules' table 

130 Added New table 'SmartPortalRefillRequests' 

130 Added New table 'SmartPortalRefillDenials' 
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SmartCare Testing Strategy – August 2025 MSP – EII 
Focus 

Purpose: 
To confirm that key workflows in each module function correctly after the release, focusing specifically on 
Engineering Improvement Initiatives (EIIs). Testing should validate both active changes (requiring 
customer setup/action) and passive changes (enabled by default but beneficial to verify). 

How to Use This Strategy 

1. Start with modules you use most often in daily operations. 
2. Within each module, test workflows tied to EII changes. 
3. Follow the navigation paths in the release notes for each task. 
4. Document: 

a. Pass / Fail outcome 
b. Unexpected behaviors 
c. Follow-up questions or concerns 

Note: The   orange icon indicates an active change, meaning the update requires customer setup or 

direct action (such as enabling a new field, adjusting a configuration, or testing a newly introduced 
workflow) rather than being applied automatically in the system. 

These testing workflows may vary depending on your organization’s specific SmartCare configuration, so 
be sure to adjust steps as needed to align with your local settings and processes. 

Testing Workflow by Module – EIIs Only 

Configuration Keys 

• EII #130593 (Passive – Customer Action: Maybe) – Test GL Extract Detail Report export to SFTP 
when exceeding row limit. 

Documents 

•   EII #130321 (Active – Customer Action: Yes) – Verify warning message displays when staff 

without proper authorization attempts to author a document. 

• EII #130801 (Passive – Customer Action: No) – Confirm NOMS Document updates display and 
save correctly for 2025 standard. 

• EII #130802 (Passive – Customer Action: No) – Test NOMS File Mapping and List page for 
updated fields. 

• EII #131639 (Passive – Customer Action: No) – Validate alert message is triggered when the 
system fails to generate a PDF. 

• EII #131753 (Passive – Customer Action: No) – Review updated “Consent to Share Health 

Information” document for correct rendering and fields. 

Dynamic Forms (DFA) 

• EII #129990 (Passive – Customer Action: No) – Test automatic hyperlink functionality in DFA list 
pages. 
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Group Services 

•   EII #130780 (Active – Customer Action: Yes) – Validate overlap warning messages and hard 

stop validation for duplicate group services. 

Interfaces 

• EII #132102 (Passive – Customer Action: No) – Confirm “Interface Status” column displays 
properly on Orders (My Office) and Client Orders (Client) list pages. 

Methadone (MAT) 

•   EII #131648 (Active – Customer Action: Yes) – Verify “Scheduled For Date” field appears in 

Medication Inventory Transaction List and Details pages. 

• EII #132198 (Passive – Customer Action: No) – Test new client search functionality 
(DOB/SSN/MRN) in MAT Management list. 

Mobile 

• EII #123604 (Passive – Customer Action: No) – Confirm searchable dropdown for client field 
works in Create Service and Create Documents screens. 

My Preference 

•   EII #130666 (Active – Customer Action: Yes) – Test new checkbox 

“NotifyForDiscontinuedMedications” on My Preferences screen. 

 

  



SmartCare Release Notes  

68 

 

My Reports / UDS Reports 

• EII #129471 (Passive – Customer Action: No) – Verify UDS Table 6B Section C (Childhood 
Immunization Status) aligns with 2025 standard. 

• EII #129476 (Passive – Customer Action: No) – Validate UDS Table 6B Section H (Statin 
Therapy) report. 

• EII #129477 (Passive – Customer Action: No) – Confirm UDS Table 6B Section I (IVD: 
Aspirin/Antiplatelet) report. 

• EII #129478 (Passive – Customer Action: No) – Validate UDS Table 6B Section J (Colorectal 
Cancer Screening) report. 

• EII #129482 (Passive – Customer Action: No) – Confirm demographic characteristics in UDS 
Table 6B Sections A & B report. 

• EII #129610 (Passive – Customer Action: No) – Validate new UDS Table 6B Section N 
(Substance Use Disorder Treatment) report for 2025. 

• EII #130339 (Passive – Customer Action: No) – Confirm UDS Table 5 Staffing & Utilization 
updates. 

• EII #131629 (Passive – Customer Action: No) – Verify Evidence Based Practices – IPP T3 
Indicator report changes. 

• EII #131686 (Passive – Customer Action: No) – Validate UDS Table Patients by ZIP Code 
updates. 

• EII #131688 (Passive – Customer Action: No) – Confirm UDS Table 3A (Patients by Age and 
Sex) updates. 

• EII #132223 (Passive – Customer Action: No) – Verify Staff 3PL Update Report. 

Reception 

•   EII #131965 (Active – Customer Action: Yes) – Test Reception/Front Desk flag icons and flag 

count column using configuration key settings. 

RWQM 

•   EII #131989 (Active – Customer Action: Yes) – Verify “Date of Service From” and “Date of 

Service To” filters function on the RWQM front end. 

• EII #132017 (Passive – Customer Action: No) – Confirm backend RWQM updates for DOS 
From/To filtering work correctly. 

Rx Application 

•   EII #130484 (Active – Customer Action: Yes) – Test Client Order diagnosis codes display 

under “Dx/Purpose” dropdown in Complete Medication Order page. 

• EII #130733 (Passive – Customer Action: No) – Validate conditional formatting highlights 
medications tied to inactive NDCs. 

• EII #131855 (Passive – Customer Action: No) – Confirm new Patient Refill Requests tab appears 
on RX application Start Page. 

Scanning 

• EII #131703 (Passive – Customer Action: No) – Verify Core Header and Footer display correctly 
in scanned and uploaded documents. 

Services 
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•   EII #129487 (Active – Customer Action: Maybe) – Test new configuration key that evaluates 

service completion lag days using both Created Date and Completion Date. 

Services / Notes 

• EII #131811 (Passive – Customer Action: No) – Validate Sensitive Information section displays 
based on configuration key value; confirm Note tab visibility for SUD service notes. 

If a Test Fails: 
Create a Zendesk ticket with the module name, task number, detailed steps to reproduce, expected vs. 
actual results, and attach any relevant screenshots or error messages. 

 

  



SmartCare Release Notes  

70 

 

Revision History 

Version Description MSP Version 

1.0 Initial Release August 2025 MSP 

 


